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Chapter 1: Introduction

This user guide describes how to use the MediByte, MediByte Jr and accompanying MediByte 
Software. The user guide has nine chapters:

1. Introduction

2. Specifications

3. Installing the Software

4. Preparing the MediByte for a Study

5. Preparing the Patient

6. Reviewing Data

7. Data Management

8. Passwords, Displays and Maintenance

9. File Transfer and Remote Scoring

In this chapter

This chapter describes the MediByte, MediByte Jr and their accessories. Included in this 
chapter:

• What’s new in MediByte Software 9.0

• Intended Use

• Conventions used in this guide

• Warnings and cautions

• Contents of the MediByte Kit and MediByte Jr Kit

• Overview of the MediByte and MediByte Jr 
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What’s New in MediByte Software 9.0
• One software program for both the MediByte and MediByte Jr. 

• Windows 10 and 11 compatibility.

• Improved security and operational logging.

• Record a sleep channel which displays EEG, EOG and EMG waveforms on the data display.

• Sleep + EEG collection montage.

• Sleep + EKG collection montage.

• On-screen AHI, RDI.

• The ability to manually add sleep stage scoring tags to the data display.

• Sleep staging hypnogram drawn in real time as the data is sleep stage scored.

• Manual marking of Central Hypopneas and Cheynes Stokes events.

• Manual marking of arousals by dragging the mouse over the EEG waveform.

• Ten-minute display width option.

• View the Photoplethysmograph (PPG signal) at the bottom of the data display.

• Pulse rate variability marking and reporting.

• Metric measurements in the setup wizard.

• Ability to change Auto Scored RERAs to Auto Scored RERAs/Subhypopneas.

• The Studies Data Manager now has a sort feature. Sort by Patient Name, Study Date and Recorder 
Type. 

• The Studies Data Manager shows the AHI, RDI and good data value in a study.

• Ability to edit and move waveforms.

• Reports no longer require Excel; updates include breathing rate; SpO2 statistics with and without 

desaturations.

• View AHI, RDI and number of minutes of good data in the study status bar.

• MediByte and MediByte Jr can now work with Bi-level PAP devices.

• Study shown to be NON-VALIDATED (only scored by assisted scoring algorithms) or VALIDATED 
(scored by a trained individual).

• Events can only be scored in non-wake stages.

• The AI, AHI, RDI and Good Data values in the status bar are updated in real-time as the user scores the 
study.

• The user can mouse over any waveform and see the actual waveform data in the status bar.
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Intended Use
The MediByte is a portable sleep data recorder used to record physiological signals during sleep 
while the patient is either at home or in a clinical environment. The data is downloaded after the 
recording is completed and the auto assist software enables the trained human professional - 
typically a Registered Sleep Technologist or Medical Doctor - to review and verify the results of 
the study and generate a report.

Target Population: Children and adult patients who are screened during sleep disorder studies. 

Environment of Use: The majority of screenings occur either in the home or in a clinical setting 
(sleep laboratory).

Indications

The MediByte is a screener used to diagnose sleep disorders, such as sleep apnea, upper airway 

resistance, snoring, periodic limb movements, bruxism.

Contraindications
This product is for diagnostic purposes only and is not to be used as an apnea monitor or in life 
sustaining or life supporting applications.
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Symbols Used On the Device and Guides

Symbols for the MediByte and MediByte Jr
These are the symbols used on the MediByte and MediByte Jr, or on its package labels. The table 
below lists the symbol, the name or meaning of the symbol.

Type BF Applied Part: F-Type applied part complying with the specified 
requirements of the IEC 60601-1 to provide a higher degree of protection 
against electric shock than that provided by Type B applied parts.

Type BF Applied Parts are not suitable for Direct Cardiac Application.

Catalogue number/reference number.

Serial Number of the device.

Medical device.

Made in Canada.

Manufacturer information.

Read operator’s manual.
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Consult instructions for use.

In compliance with the European Directive on Waste of Electrical and 
Electronic Equipment (WEEE) 2002/96/EC, do not dispose of this product as 
unsorted municipal waste

Operating temperature limit.

Operating humidity limit.

Keep dry.

Transport and storage temperature limit.

Transport and storage humidity limit.

IP22
Ingress protection: IP22; as defined by IEC 60529 is protected from touch by 
fingers and objects greater than  12.5 mm diameter, and liquids from spray 
less than 15 degrees from vertical.

Authorized representative in the European Community.

UK Conformity Assessed marking.
  1-5
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Conventions for the User and Patient Guides

Following are document and safety conventions. 

Warning: This symbol flags a serious warning. It is vital that you 
heed all warnings to prevent injury to yourself or to your patient.

Caution: This symbol flags a caution. Heed all cautions to prevent 
damage to your equipment.

Note: This symbol flags a note. Notes provide important information 
about using the MediByte/MediByte Jr, its accessories and the 
software.

Protect from heat and radioactive sources.

Keep dry.

No nail polish.
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Warnings and Cautions

• MediByte/MediByte Jr record signals for use in assessing sleep disorders. Ensure all studies are 
reviewed by a qualified person. A licensed physician is required, by law, to diagnose sleep apnea 
because it is a medical condition.

• To protect the patient, never connect the MediByte/MediByte Jr to the computer while the patient is 
still hooked-up to the MediByte/MediByte Jr.

• Always use a new BRAEBON cannula and BRAEBON hydrophobic (safety) filter with each patient.

• Do NOT use or attempt to service damaged parts.

• Unauthorized opening of the MediByte/MediByte Jr will void both the safety of the MediByte/
MediByte Jr and the terms and conditions of the MediByte warranty. No modification of this 
equipment is allowed.

• Do not modify this equipment without authorization from the manufacturer.

• If this equipment is modified, appropriate inspection and testing must be conducted to ensure 
continued safe use of the equipment.

• Keep the MediByte/MediByte Jr and its components away from flames.

• Do NOT use the MediByte/MediByte Jr in the presence of flammable compounds such as anesthetics.

• Do NOT immerse the MediByte/MediByte Jr in any liquids because damage will result. Advise all 
patients to keep the MediByte/MediByte Jr away from water. Water damage will void the warranty.

• Do NOT sterilize the MediByte/MediByte Jr.

• Do NOT perform unattended sleep studies on patients who are not physically able to use the 
MediByte and its accessories.

• To prevent strangulation, ensure all leads and wires are taped-down.

• Misapplication of an SpO2 probe with excessive pressure for prolonged periods can induce pressure 

injury.

• Conductive parts of electrodes and associated connectors for applied parts, including the neutral 
electrode, should not contact other conductive parts including earth.

• MediByte should not be used along with HF surgical instruments.

• Ensure the SpO2 sensor is not too tight. Misapplication of a probe with excessive pressure for 
prolonged periods can induce pressure injury. 

This product is for diagnostic purposes only and is NOT to be used as an apnea monitor or in 
life sustaining or life supporting applications.

Warnings
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• The SpO2 sensor contains no alarms.

• Wear the MediByte or MediByte Jr over clothing to reduce the risk of allergic reaction.

Battery Warning Saft LS14250:

• Do not attempt to recharge the Saft LS14250 battery.

• Battery to be replaced by qualified personnel only.

• Remove the battery if the device is not to be used for an extended period of time.

• Fire, explosion and severe burn hazard. Do not recharge, short circuit, crush, disassemble, heat above 
100 OC (212 OF), incinerate or expose contents to water.

Battery Warning BRAEBON Rechargeable:

• Battery to be replaced by qualified personnel only.

• Remove the battery if the device is not to be used for a long period of time.

• Fire, explosion and severe burn hazard. Do not short circuit, crush, disassemble, heat above 100 OC 
(212 OF), incinerate or expose contents to water.
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• Use only BRAEBON sensors and accessories.

• Use only the BRAEBON RIP Belts for MediByte (Models 8572, 8572PED, 8574). Other belts will NOT 
function with the MediByte.

• Always use a new cannula and BRAEBON hydrophobic (safety) filter with each patient. 

• Sterilization of the MediByte is NOT required. Do NOT steam autoclave the MediByte or damage will 
occur and void the warranty. 

• Do NOT immerse the MediByte in any liquids as damage will result. Advise all patients to keep the 
MediByte away from water; water damage will void the warranty.

• Do NOT drop the MediByte. 

• Use only 3.6 V 1/2AA battery, Saft LS14250 (Model 0410) or 1/2AA Li-Ion Rechargeable Battery (Model 
0412) supplied by BRAEBON. 

• Do NOT recharge the Saft LS14250 (Model 0410) battery; it is non-rechargeable.

• Ensure the polarity of the battery is correct when inserting; otherwise, the device will not operate.

• Operate and store the MediByte under the following environmental conditions:

Operating Conditions
Storage and Transport 
Conditions

Temperature 10C–35C 0C–50C

Relative Humidity 30%–95% 
(Without condensation)

10%–100%

Cautions
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Contents of the MediByte Kit
Verify that you have received the items listed in the MediByte Kit and that no items were 
damaged during shipping. If any items are damaged or missing, please contact BRAEBON 
immediately at 1.888.462.4841. Do NOT use damaged items.

MediByte Kit Contents 

Rechargeable Battery Kit is an available add-on. See page 1-12 for content list.

Quantity Item

1 MediByte Recorder (Model MP-8)

2 RIP Belt for MediByte (Model 8572)

1 MediByte Electrode Prep Kit (Model 8128)

1 MediByte Electrode Prep Kit - five piece (Model 8128-5)

6 Self-Adhesive Electrodes, strip of 5 (Model 8501-5)

1 Ultima Snore Microphone for MediByte with Thermistor Input (Model 8541)

1 Electrode Box (Model 8611)

1 Leadwire Kit for MediByte (Model 8620)

1 cTherm Cannula Thermistor (Model 8514)

1 SpO2 Cable for MediByte, Soft Fingertip (Model 8900)

1 MediByte Carrying case

1 USB Cable for MediByte (Model 8890)

1 MediByte Patient Guides (Model 8940)

1 MediByte/MediByte Jr User Manual (installed with software)

1 Hex Screwdriver for MediByte (Model 8870)

1 MediByte/MediByte Jr First Patient Setup Guide
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Contents of the MediByte Lite Kit
Verify that you have received the items listed in the MediByte Lite Kit and that no items were 
damaged during shipping. If any items are damaged or missing, please contact BRAEBON 
immediately at 1.888.462.4841. Do NOT use damaged items.

MediByte Lite Kit Contents 

Rechargeable Battery Kit is an available add-on. See page 1-12 for content list.

Quantity Item

1 MediByte Recorder (Model MP-8)

2 RIP Belt for MediByte (Model 8572)

1 MediByte Patient Kit (Model 8110)

1 MediByte Patient Kit - five piece (Model 8110-5)

1 SpO2 Cable for MediByte, Soft Fingertip (Model 8900)

1 MediByte Carrying case

1 USB Cable for MediByte (Model 8890)

1 MediByte Patient Guides (Model 8940)

1 MediByte/MediByte Jr User Manual (installed with software)

1 Hex Screwdriver for MediByte (Model 8870)

1 MediByte/MediByte Jr First Patient Setup Guide
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Contents of the MediByte Jr Kit
Verify that you have received the items listed in the MediByte Jr Kit and that no items were 
damaged during shipping. If any items are damaged or missing, please contact BRAEBON 
immediately at 1.888.462.4841. Do NOT use damaged items.

MediByte Jr Kit Contents 

Rechargeable Battery Kit is an available add-on. 

Battery Charger Kit (Models 0444-N.A., 0445-E.U.)

Quantity Item

1 MediByte Jr Recorder (Model MBJR)

1 RIP Belt for MediByte (Model 8572)

1 SpO2 Cable for MediByte, Soft Fingertip (Model 8900)

1 Patient Kit (Model 8110)

1 MediByte Jr Carrying case

1 USB Cable for MediByte (Model 8890)

1 Patient Guide to MediByte Jr (Model 8926)

1 MediByte/MediByte Jr User Manual (installed with software)

1 MediByte/MediByte Jr First Patient Setup Guide

Quantity Item

1
1/2 AA Lithium Battery Charger Kit (Model 0429): contains 1/2 AA 
Battery Charger (Model 0422) and 1/2 AA Lithium Batteries - 2 pack 
(Model 0412-2)

1 of
AD/DC Power Adapter, 12 V, 0.5 A, Europe, Type C (Model 0426)

AD/DC Power Adapter, 12 V, 0.5 A, North America, Type A (Model 0424)

Also 
available

AD/DC Power Adapter, 12 V, 0.5 A, United Kingdom, Type G (Model 
0428)
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Components and Accessories for MediByte (* available, not in kit)

Item Device Name Description

8572
8572PED*
8574*

RIP Belts for MediByte, 
Medium, small*, large* 
(MediByte/ MediByte Jr)

Plug into the chest and abdomen ports on the MediByte, used to 
detect respiratory effort.

8541

Ultima Snore Microphone 
for MediByte with 
Thermistor Input (MediByte 
only)

Plugs into the AUX port on the MediByte, used to detect snore 
sounds.

8611
Electrode Box (MediByte 
only)

Plugs into the AUX port on the MediByte, used to connect 
electrodes to the MediByte. 

8612*
Electrode Box SE (MediByte 
only)

Plugs into the AUX port on the MediByte, used to connect 
electrodes to the MediByte for Sleep + EKG and Sleep + EEG 
montages. 

8620
Leadwire Kit for MediByte 
(MediByte only)

Plugs into the Electrode Box on the MediByte, leadwires for 
connecting the self-adhesive electrodes. Contains nine leadwires: 
five 24” leadwires and four 60” leadwires.

8514
cTherm Cannula Thermistor 
for MediByte (MediByte 
only)

Plugs into the white input port on the snoring microphone or 
Electrode Box; used to measure airflow.

8896*
SpO2 Cable for MediByte

(MediByte/ MediByte Jr)

Plugs into the SpO2 port on the MediByte, measures blood 

oxygen saturation and pulse (Flexiwrap style).

8898*
SpO2 Cable for MediByte, 
Large Soft Shell
(MediByte/ MediByte Jr)

Plugs into the SpO2 port on the MediByte, measures blood 

oxygen saturation and pulse.

8899*

SpO2 Cable for MediByte, 

Earlobe
(MediByte/ MediByte Jr)

Plugs into the SpO2 port on the MediByte, measures blood 

oxygen saturation and pulse.

8900

SpO2 Cable for MediByte, 

Soft Fingertip 
(MediByte/ MediByte Jr)

Plugs into the SpO2 port on the MediByte, measures blood 

oxygen saturation and pulse (silicon finger pouch style).

8890
USB Cable for MediByte
(MediByte/ MediByte Jr)

Connects the MediByte to the computer; used to program the 
MediByte for a study and for data download. 

8110-25*
MediByte Patient Kit 
(MediByte/ MediByte Jr)

Package containing 25 of each: disposable 8597 Oronasal 
cannula, Paper Tape. 
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8115-25*
MediByte Patient Kit 
(MediByte/ MediByte Jr)

Package containing 25 of each: disposable 8597 Oronasal 
cannula, 3.6V 1/2 AA Lithium battery. (North America only)

8119-25*
MediByte Patient Kit 
(MediByte/ MediByte Jr)

Package containing 25 of each: disposable 8597 Oronasal 
cannula, 3.6V 1/2 AA Lithium battery, Paper Tape. 
(North America only)

8120-25*
MediByte Patient Kit 
(MediByte/ MediByte Jr)

Package containing 25 of each: Nonin Flexiwrap Probe Tape, 3.6 V 
1/2 AA Lithium battery, 8597 Oronasal cannula. For use with the 
8896 SpO2 cable for MediByte.

 (North America only)

8128-5
MediByte Electrode Prep Kit 
(MediByte only)

Package containing 5 of each: disposable 8597 Oronasal cannula, 
electrode prep pads and Paper Tape.

8128-20*
MediByte Electrode Prep Kit 
(MediByte only)

Package containing 20 of each: disposable 8597 Oronasal 
cannula, self-adhesive electrodes (20x5), electrode prep pads and  
Paper Tape. Not recommended for MediByte Jr.

8129-20*
MediByte Electrode Prep Kit 
(MediByte only)

Package containing 20 of each: disposable 8597 Oronasal 
cannula, self-adhesive electrodes (5x20), electrode prep pads, 
Paper Tape, 1/2 AA Lithium battery. Not recommended for 
MediByte Jr. (North America only)

8130-20*
MediByte Electrode Prep Kit 
(MediByte only)

Package containing 20 of each: disposable 8597 Oronasal 
cannula, self-adhesive electrodes (5x20), Paper Tape, 1/2 AA 
Lithium battery. Not recommended for MediByte Jr.  
(North America only)

8501-5
Vermed Self-Adhesive 
Electrodes 
(MediByte only)

Package containing 5 of each: disposable electrodes to apply to 
the patient for PLM, EKG, Brux and sleep studies. 

8870
Hex Screwdriver for 
MediByte

Screwdriver for tightening the screw on the battery 
compartment.

Carrying Case Case to transport the MediByte or MediByte Jr.

8920
MediByte/MediByte Jr User 
Manual

User Guide for the clinician (downloaded with software).

8925/8940 Patient Guide User Guide for the patient.

MediByte/MediByte Jr First 
Patient Setup Guide

Quick-start guide for new users (clinician).

Item Device Name Description
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Overview of the MediByte and MediByte Jr
The Medibyte and MediByte Jr were designed for quick clinician-to-patient turnaround. The 
clinician prepares the recorder for data collection using the supplied MediByte Software. After 
the clinician prepares the MediByte (or MediByte Jr), the patient sleeps with the device and 
returns it to the clinician for data download and analysis. The data download and data analysis 
are performed using the MediByte Software. After reviewing the data, the clinician generates a 
report using the software.

Description of the MediByte and MediByte Jr
The MediByte and MediByte Jr are compact ambulatory devices designed to efficiently aid in the 
detection of a number of sleep disorders; such as apnea, upper airway resistance and snoring. 
Because of their small size and portability, clinicians are no longer limited to recording data in an 
artificial sleep environment. Data collection can occur in the patient’s natural surroundings, over 
a more extensive period than might otherwise be practical in a sleep lab.

The MediByte is available in two models: the MediByte and the MediByte Jr.

The MediByte records up to 15 channels of physiological signals: oximetry; heart rate; 
photoplethysmography; pressure (flow); snore (derived from pressure); thermal flow; RIP chest 
effort; RIP abdominal effort; SUM (derived); event marker; body position; EEG, EOG, EMG and 
EKG (using AUX); or EKG, or EMG or snore audio (using AUX), sound level; CPAP flow and CPAP 
pressure. 

The MediByte Jr records up to seven channels of physiological signals: oximetry; heart rate; 
pressure (flow); snore (derived from pressure); RIP chest effort; event marker; body position; 
CPAP flow and CPAP pressure. The MediByte Jr does not have an AUX port.

The MediByte and MediByte Jr consist of the following major components:

• the MediByte/MediByte Jr recorder

• the USB cable

• BRAEBON sensors

• MediByte Software.

The MediByte Recorder
The MediByte recorder has a plastic molded case with an Event button and Status LED on the 
front. On the top portion of the recorder, there is an auxiliary (AUX) port for snoring volume or 
EKG/EMG sensors, a pressure port and an SpO2 port. On the bottom portion of the recorder, 
  1-15
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there is a communication port, a chest port, an abdomen port and a collection on/off switch. See 
Figure 1.2 on page 1-17 for port locations.

The Event button, located on the front of the recorder, 
permits the patient to record an event by depressing 
the button. The event marker is defined by the clinician 
within the software. Common events are lights out, 
lights on and bathroom break.

The Status LED is a small light located on the front of 
the recorder; it flashes green or red to indicate the 
current state of the unit. For example, the LED flashes 
green once every six seconds to show that the recorder 
is waiting to collect; and it flashes green twice every six 
seconds to show that the recorder is collecting. 
Continuous red blinking indicates that the battery is too 
low to record a study, although it may have enough 
charge remaining to download data. See Displays and 
Indicators on page 2-5 for a complete list of Status LED 
indicators.

The Auxiliary Port (AUX), located on the top of the recorder, attaches either the snoring 
microphone (with or without thermistor) or either version of Electrode Box to the MediByte. 

The Pressure Port, located on the top of the recorder, attaches the oral/nasal cannula to the 
recorder. You can also use this port to record CPAP pressure.

The SpO2 Port, located on the top of the recorder, attaches the SpO2 cable to the recorder. 

The Communication Port, located on the bottom of the recorder, accepts the BRAEBON USB 
cable. Use this port to attach the recorder to the computer to configure a study and to download 
the data from the recorder. Never attach the unit to the computer when it is already attached 
to the patient.

The Chest Port attaches the RIP Belt for MediByte to the recorder.

The Abdomen Port attaches the RIP Belt for MediByte to the recorder.

The Collection On/off Switch sets the unit to record when in the manual mode. To start the 
recording, push the switch to the right (white dot). This switch only functions when the unit has 
been preset to manually record within the software. The collection on/off switch is disabled if 

Figure 1.1: MediByte ON/OFF
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the unit is preset to automatically record within the software. It is also disabled when the unit is 
connected to the computer.

For optimized performance and ease-of-use, BRAEBON recommends the automatic mode.

Figure 1.2:  MediByte port locations
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BRAEBON Sensors

The MediByte uses the following BRAEBON sensors:

• Two RIP Belts for MediByte Belt (Model 8572). The RIP Belts for MediByte plug into the chest and 
abdomen ports on the MediByte. The belts detect the expansion and contraction of the abdomen and 
chest (effort) and contributes to the diagnosis of sleep apnea. 

• One Ultima Snore Microphone for MediByte (Model 8541). The Ultima Snore Microphone for 
MediByte, which plugs into the AUX port on the MediByte, detects snore sounds.

• One Electrode Box (Model 8611). The Electrode Box, which plugs into the AUX port on the MediByte, 
attaches electrodes to the MediByte. Use this for Sleep, EKG, PLM and Bruxism studies.

• One (optional) Electrode Box SE (Model 8612). The Electrode Box SE, which plugs into the AUX port 
on the MediByte, attaches electrodes to the MediByte. Use this for Sleep + EKG or Sleep + EEG 
studies.

• One SpO2 Cable for MediByte (Model 8900). The SpO2 Cable for MediByte, which plugs into the SpO2 

port on the MediByte, measures blood oxygen saturation and pulse. It is used to aid in the diagnosis 
of sleep apnea. The status of the SpO2 signal can be reviewed after the data has been downloaded.

• One oral/nasal cannula (Model 8597). The oral/nasal cannula, which plugs into the pressure port on 
the MediByte, measures airflow. It is used to aid in the diagnosis of sleep apnea. 

• One cTherm cannula thermistor (Model 8514). The cTherm cannula thermistor, which plugs into the 
white input port on the snoring microphone (8541) or Electrode Box (8611), measures airflow using 
thermistors. It is used to aid in the diagnosis of sleep apnea.
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The MediByte Jr Recorder
The MediByte Jr recorder has a plastic molded case with a Status LED on the front. On the top 
portion of the recorder, there is a pressure port and an SpO2 port. On the bottom portion of the 
recorder, there is a communication port, a chest port and a collection on/off switch. See Figure 
1.4 on page 1-20 for port locations.

The Status LED is a small light located on the front of 
the recorder; it flashes green or red to indicate the 
current state of the unit. For example, the LED flashes 
green once every six seconds to show that the recorder 
is waiting to collect; and it flashes green twice every six 
seconds to show that the recorder is collecting. 
Continuous red blinking indicates that the battery is too 
low to record a study, although it may have enough 
charge remaining to download data. See Displays and 
Indicators on page 2-5 for a complete list of Status LED 
indicators.

The Pressure Port, located on the top of the recorder, 
attaches the oral/nasal cannula to the recorder. You can 
also use this port to record CPAP pressure.

The SpO2 Port, located on the top of the recorder, 
attaches the SpO2 cable to the recorder. 

The Communication Port, located on the bottom of the recorder, accepts the BRAEBON USB 
cable. Use this port to attach the recorder to the computer to configure a study and to download 
the data from the recorder. Never attach the unit to the computer when it is already attached 
to the patient.

The Chest Port attaches the RIP Belt for MediByte to the recorder.

The Collection On/off Switch sets the unit to record when in the manual mode. To start the 
recording, push the switch to the right (white dot). This switch only functions when the unit has 
been preset to manually record within the software. The collection on/off switch is disabled if 
the unit is preset to automatically record within the software. It is also disabled when the unit is 
connected to the computer.

Figure 1.3: MediByte Jr 
ON/OFF
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The MediByte Jr uses the following BRAEBON sensors:

• One RIP Belt for MediByte (Model 8572). The RIP Belt for MediByte plugs into the chest port on the 
MediByte Jr. The belt detects the expansion and contraction of the chest (effort) and contributes to 
the diagnosis of sleep apnea. 

• One SpO2 Cable for MediByte (Model 8900). The SpO2 Cable for MediByte, which plugs into the SpO2 

port on the MediByte Jr, measures blood oxygen saturation and pulse. It is used to aid in the diagnosis 
of sleep apnea. 

• One oral/nasal cannula (Model 8597). The oral/nasal cannula, which plugs into the pressure port on 
the MediByte Jr, measures airflow. It is used to aid in the diagnosis of sleep apnea. 

MediByte Software
MediByte Software is the software designed to work exclusively with the MediByte/MediByte Jr. 
The software has a handy configuration wizard to help you quickly configure the recorder for a 
study. Enter the patient name, patient ID, patient weight and select the type of study you want to 
perform. The software sends this information to the recorder, telling it what types of channels 
are to be recorded and with whom to associate the data. After the patient has completed the 
study, download the data from the recorder onto the computer. The software will assist with 
data analysis. After you have reviewed the analysis and made any changes, you can enter more 
information into the Patient Info window and then generate and print a report.

Figure 1.4:  MediByte Jr port locations
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BRAEBON Batteries
The MediByte/MediByte Jr uses a 3.6 V 1/2AA battery, Saft LS14250 (Model 0410-3) or a 1/2 AA 
Li-Ion Rechargeable Battery (Model 0412) supplied by BRAEBON. The Saft non-rechargeable 
battery can be used for a two-night study whereas the 1/2 AA Li-Ion Rechargeable Battery is good 
for a one-night study.

To recharge the rechargeable batteries, use the supplied 1/2 AA Lithium Battery Charger 
(Model 0422). Only charge rechargeable batteries; the Saft batteries cannot be recharged. Non-
rechargeable batteries will cause the charger to overheat and may cause a fire or explosion.

The battery charger has an LED sequence as shown in the following table.

Table 1-1: Battery Charger LED Sequence

LED Meaning

Red, always on Battery is charging

Blue, always on Battery is fully charged

Blue flash, red flash
Battery polarity is incorrect; reverse the direction of the batteries to 
continue.

Blue flash, red flash
If the battery polarity is correct, this indicates a voltage of less than 
2.7V. Leave the batteries in the charger and after the voltage rises 
above 2.7V, the LED will change to red to indicate charging.
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Chapter 2: Specifications

In this chapter

This chapter contains a number of tables which describe the MediByte and MediByte Jr. Also 
included are the manufacturer’s declarations which show how the unit complies to the IEC 
Standard 60601-1. Included in this chapter:

• System requirements

• MediByte and MediByte Jr classification 

• MediByte and MediByte Jr specifications

• Pulse oximeter specifications

• Displays and indicators

• Controls

• Manufacturer’s declarations
  2-1
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Specifications
System Requirements
The MediByte Software runs on a Windows computer. 

Computer Processor

Intel: i5, i7 or higher

or

AMD: Zen Core Architecture, Ryzen 5 (or higher)

Hard drive 1/2 TB or larger with a minimum of 5 GB available space.

Minimum RAM 8GB

USB Port 2.0 (or higher)

Operating System Windows 10 (or higher)

Software Word 2016 (or higher)



Specifications
MediByte and MediByte Jr Classification and Specifications

Table 2-1: MediByte and MediByte Jr Recorder Classification as per IEC 60601-1

Internally powered

Type BF

Ingress protection: IP22; as defined by IEC 60529 is protected from touch by fingers and objects greater than  
12.5 mm diameter, and liquids from spray less than 15 degrees from vertical.

Sterilization not required, refer to cleaning methods

Category not anaesthetic proof, not suitable for such application

Continuous operation

Table 2-2: MediByte and MediByte Jr Specifications

Dimensions 2.5” x 2.25” x 0.75” (66 mm x 60 mm x 19 mm)

Weight 3.3 oz. with battery (93 g) MediByte
3.2 oz with battery (91 g) MediByte Jr

Case Plastic (ABS)

Power 1/2 AA 3.6 V Saft LS 14250; max power 25 mA @ 3.6 VDC 

Memory Can store up to 18 hours of data (with audio) or 24 hours (with EMG-MediByte only)

MediByte and MediByte Jr contain no alarm systems.
  2-3



2-4  

Specifications
Table 2-3: Pulse Oximeter Specifications

Oxygen Saturation Range 0 to 100%

Pulse Rate Range 18 to 300 pulses per minute

Measurement Wavelengths Using 
Nonin Sensors 

Red: 660 nanometers @ 3mW Nominal
Infrared: 910 nanometers @ 3mW Nominal

Accuracy
SpO2 (70-100%) (± 1 SD)

No Motion - Adults, Pediatrics ± 2 digits; Neonates ± 3 digits
Motion - Adults, Pediatrics ± 2 digits; Neonates ± 3 digits
Low Perfusion- Adults, Pediatrics ± 2 digits; Neonates ± 3 digits

Accuracy
Heart Rate

No Motion (18 - 300 BPM) - Adults, Pediatrics, Neonates ±3 digits
Motion (40 - 240 BPM) - Adults, Pediatrics, Neonates ±5 digits
Low Perfusion (40 - 240 BPM) - Adults, Pediatrics, Neonates ±3 digits

PULSE OXIMETER EQUIPMENT is calibrated to display FUNCTIONAL OXYGEN SATURATION.

Device and accessories have been tested to EN ISO 80601-2-61:2019

a) SpO2 probes are designed for use with specific monitors;

b) the OPERATOR is responsible for checking the compatibility of the monitor, probe and cable before use; 
and
c) incompatible components can result in degraded performance.

Note: Only BRAEBON-provided SpO2 probes are compatible with MediByte and MediByte Jr.



Specifications
Displays and Indicators

Table 2-4: Displays and Indicators

LED Status

At battery insertion, green/red alternating for four seconds Unit functioning

Not flashing Battery not inserted, battery dead

Flashing green once every six seconds Recorder is waiting to collect

Flashing green twice every six seconds Recorder is collecting

Flashing red once every six seconds Low battery

Flashing red twice every six seconds No SpO2/Pulse signal

Blinking red continuously Battery too low for a study; will not record 
data but may still work for data download

Solid green for up to one minute, then green twice every six 
seconds

MediByte/MediByte Jr is turned on using the 
ON/OFF switch

Table 2-5: Controls

Control Function

Event button When pressed, the event button records the button press. The event is predefined 
by the clinician. (MediByte only)

Collection on/off switch The MediByte / MediByte JR will start collecting data when the switch is moved to 
the right (white dot). The switch is de-activated in the automatic mode.
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Manufacturer’s Declaration

Table 2-6: IEC 60601-1-2 Statements

Clause 6.8.2.201 a) 1) Medical Electrical Equipment needs special precautions regarding EMC and needs 
to be installed and put into service according to the EMC information provided in 
this manual.

Clause 6.8.2.201 a) 2) Portable and mobile RF communications equipment can affect Medical Electrical 
Equipment.

6.8.3.201 a) 1) The use of accessories, transducers, and cables other than those specified by the 
manufacturer, may result in increased Emissions or decreased Immunity of the 
System.

6.8.3.201 a) 4) The System should not be used adjacent to or stacked with other equipment and 
that if adjacent or stacked use is necessary, the System should be observed to verify 
normal operation in the configuration in which it will be used.

Table 2-7: Guidance and Manufacturer’s Declaration - Electromagnetic Emissions

The MediByte is intended for use in the electromagnetic environment specified below. The customer or the user 
of the MediByte should assure that it is used in such an environment.

Emissions Test Compliance Electromagnetic Environment - Guidance

RF emissions
CISPR 11

Group 1 The MediByte uses RF energy only for its internal 

function. Therefore, its RF emissions are very low and 
are not likely to cause any interference in nearby 
electronic equipment.

RF emissions
CISPR 11

Class B The MediByte is suitable for use in all establishments, 

including domestic establishments and those directly 
connected to the public low-voltage power supply 
network that supplies buildings used for domestic 
purposes.

Harmonic emissions
IEC 61000-3-2

Class B

Voltage fluctuations/
flicker emissions
IEC 61000-3-3

Complies
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Table 2-8: Guidance and Manufacturer’s Declaration - Electromagnetic Emissions

The MediByte is intended for use in the electromagnetic environment specified below. The customer or the user 
of the MediByte should assure that it is used in such an environment.

Immunity Test IEC 60601 test level Compliance level Electromagnetic environment guidance

Electrostatic
discharge (ESD)
IEC 61000-4-2

±6 kV contact

±8 kV air

±6 kV contact
±8 kV air

Floors should be wood, concrete or 
ceramic tile. If floors are covered with 
synthetic material, the relative humidity 
should be at least 30%.

Electrical fast
transient/burst
IEC 61000-4-4

±2 kV for power
supply lines

±1 kV for input/output 
lines

Not applicable. 
Battery powered.

Mains power quality should be that of a 
typical commercial or hospital 
environment.

Surge
IEC 61000-4-5

±1 kV differential
mode

±2 kV common mode

Not applicable. 
Battery powered.

Mains power quality should be that of a 
typical commercial or hospital 
environment.

Voltage dips, 
short 
interruptions and 
voltage variations
on power supply 
input lines
IEC 61000-4-11

<5% UT

(>95% dip in UT)

for 0,5 cycle

40% UT

(60% dip in UT)

for 5 cycles

70% UT

(30% dip in UT)

for 25 cycles

<5% UT

(>95% dip in UT)

for 5 sec.

Not applicable. 
Battery powered.

Mains power quality should be that of a 
typical commercial or hospital 
environment. If the user of the 
MediByte requires continued operation 
during power mains interruptions, it is 
recommended that the MediByte be 
powered from an uninterruptible power 
supply or a battery.

Power frequency 
(50/60 Hz) 
magnetic field IEC 
61000-4-8

3 A/m 3 A/m Power frequency magnetic fields should 
be at levels characteristic of a typical 
location in a typical commercial or 
hospital environment

NOTE UT is the a.c. mains voltage prior to application of the test level.
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Table 2-9: Guidance and Manufacturer’s Declaration - Electromagnetic Immunity - For Equipment 
and Systems that are not Life-Supporting

The MediByte is intended for use in the electromagnetic environment specified below. The customer or the user 
of the MediByte should assure that it is used in such an environment.

Immunity Test IEC 60601 test level Compliance level Electromagnetic environment guidance

Conducted RF
IEC 61000-4-6

3 Vrms
150 kHz to 80 MHz

3 V Portable and mobile RF communications 
equipment should be used no closer to 
any part of the MediByte, including 
cables, than the recommended 
separation distance calculated from the 
equation applicable to the frequency of 
the transmitter.

Radiated RF

IEC 61000-4-3

3 V/m
80 MHz to 2,5 GHz

3V/m

where P is the maximum output power
rating of the transmitter in watts (W)
according to the transmitter
manufacturer and d is the recommended 
separation distance in metres (m). Field 
strengths from fixed RF transmitters, as 
determined by an electromagnetic site 
survey, a should be less than the 
compliance level in each frequency 
range.b

Interference may occur in the vicinity of
equipment marked with the following
symbol:
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NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption

and reflection from structures, objects and people.

a
 Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless), mobile radios, 

amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted with accuracy. To assess the 
electromagnetic environment due to fixed RF transmitters, a survey should be considered. If the measured field 
strength in the location in which the MediByte is used exceeds the applicable RF compliance level above, the 
MediByte should display normal operation. If abnormal performance is observed, additional measures may be 
necessary, such as reorienting or relocating the MediByte.
b

 Over the frequency range 150 kHz to 80 MHz, field strengths should be less than [3] V/m.

Recommended separation distances between portable and mobile RF communications equipment and the 
MediByte

The MediByte is intended for use in an electromagnetic environment in which radiated RF disturbances are 
controlled. The customer or the user of the MediByte can help prevent electromagnetic interference by 
maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) 
and the MediByte as recommended below, according to the maximum output power of the communications 
equipment.

Rated maximum output
power of transmitter

(W)

Separation distance according to frequency of transmitter m

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in 
metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the 
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.
NOTE 1: At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.
NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 
and reflection from structures, objects and people.

Table 2-9: Guidance and Manufacturer’s Declaration - Electromagnetic Immunity - For Equipment 
and Systems that are not Life-Supporting
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Table 2-10: Pulse Oximeter probes validated and tested for compliance with EN ISO 80601-2-61

8896 SpO2 Cable for MediByte 

8898 SpO2 Cable for MediByte, Large Soft Shell

8899 SpO2 Cable for MediByte, Earlobe

8900 SpO2 Cable for MediByte, Soft Fingertip



Chapter 3: Installing the Software

In this chapter

This chapter describes how to install the MediByte software onto your computer. After you 
have installed the software, you can configure the MediByte/MediByte Jr and start collecting 
data. You cannot collect data until you have installed the software and configured the 
recorder. When you configure the recorder, you are telling it the name of the patient and the 
study parameters.

This chapter includes: 

• Installing the MediByte software 

• Connecting the MediByte/MediByte Jr to the computer

• Activating the MediByte software
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Installing the Software
Installing the MediByte Software
The MediByte software is installed from the Braebon.com website. After you have installed the 

software, a MediByte icon  will be placed on your desktop. 

To install the software:

Installing the software is easy, an installation wizard will guide you through the process.

1. In your web browser (eg., Internet Explorer, Firefox), type braebon.com/setup.

2. Click MediByte.

• Click the red Download link beside MediByte 
Software. The system is designed to start the 
installation process, but your web browser 
may not allow this. A new window may open 
asking whether you want to save the file, click 
Save File. The software will then download to 
your computer, usually in the Downloads 
folder.

3. Double-click on the MediByte Installer File. 

4. A security window may open asking you 
whether you want to run the file. Click Run.
The MediByte Installation Wizard will open.

5. Click Next to open the Software License 
Agreement.

6. Review the software license agreement, and if 
you accept the terms, click the radio button 
beside I accept the terms of the license 
agreement, and click Next.

7. Click Install.

8. Click Finish to exit the Installation Wizard.
The software installs in C:\Program Files (x86)\MediByte v9.0 by default. You will find the 

MediByte icon  on your desktop.

Figure 3.1: MediByte Software download

Figure 3.2: Installation Wizard



Installing the Software
Connecting the MediByte to the Computer

1. Insert a battery into the MediByte. 

2. Using the MediByte USB Cable, connect the large connector to your computer’s USB port and 
connect the small connector to the MediByte communication port. The first time you 
connect a MediByte to the computer, the MediByte hardware drivers will automatically 
install.

3. Double-click the MediByte software icon  to start the MediByte Software.

Install the software before you connect the MediByte to the computer.
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Installing the Software
Activating the MediByte Software 
The first time you use the MediByte Software, you are required to authorize it. Authorizing the 
software consists of entering the serial number of your MediByte and an activation code into the 
BRAEBON on-line activation page. The page will generate an authorization code to be typed into 
the Software Activation page. If you do not have Internet access call 1.888.462.4841 (9-5 EST).

1. Double-click the MediByte software icon  on the desktop. This action will open the 

Software Activation Page.

2. Using the dropdown menu, select the language you want to use. Select the language before 
activating the MediByte. You can also change the language within the Analysis screen in the 
MediByte Software.

3. Make a note of the Activation Code shown on the screen. 

4. Select the Click Here button to open the BRAEBON on-line activation page.

5. Type the Activation Code into the Activation Code field on the on-line activation page.

116893

73673

Figure 3.3: Activating the MediByte Software online

253939



Installing the Software
6. Type the serial number from the back of your MediByte/MediByte Jr into the Serial# field on 
the on-line activation page. You can also find the serial number on the packaging label.

7. Click Activate MediByte. You will receive an Authorization Code, enter it into the Enter 
Authorization Code field on the Software Activation screen, and click Authorize.

8. A pop-up window will notify you of your success. You are now ready to use the MediByte 
software.

522522
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Chapter 4: Preparing the MediByte 

In this chapter 

This chapter describes how to prepare the MediByte and MediByte Jr for a study. To prepare a 
recorder, you must connect it to the computer and use the MediByte wizard to program it.

This chapter includes information about how to:

1. Insert a new battery into the MediByte/MediByte Jr;

2. Connect the MediByte/MediByte Jr to the computer and start the software;;

3. Select an operation;

4. Enter patient information;

5. Select an auxiliary device (MediByte only);

6. Select the start time;

7. Review the settings and configure the MediByte/MediByte Jr;

8. Prepare a kit for the patient.
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Preparing the MediByte
Preparing the MediByte for a Study

Preparing the MediByte/MediByte Jr for a study consists of the following steps:

1. Insert a new battery into the MediByte/MediByte Jr.

2. Use the USB cable to connect the MediByte/MediByte Jr to the computer and click on the 
MediByte Software icon to start the MediByte Software.

3. Select an operation in the MediByte wizard.

4. Enter the patient name, ID and weight.

5. Select an auxiliary device (MediByte only).

6. Select the start time.

7. Review the settings and configure the MediByte/MediByte Jr.

1.  Insert a fresh Battery into the MediByte/MediByte Jr
The Saft LS14250battery, Model 0410-3, lasts for two over-night studies. To ensure that you 
don’t lose power during a study, make it a habit to insert a fresh battery before you configure 
the MediByte/MediByte Jr. If you are using rechargeable batteries, you cannot run a two-
night study without changing batteries between studies.

1.  Using the hex screwdriver provided with your kit, remove the battery compartment 
screw.

2.  Remove the battery compartment cover by pushing it down and away from you. Use the 
ribbon to extract the used battery.

3.  With the ribbon on the bottom of the battery compartment, insert a new battery 
ensuring the polarity of the battery matches the diagram on the bottom of the 
compartment.

4.  Replace the battery compartment cover, reinsert and tighten the screw. Do not over-
tighten the screw as this may strip it.

Before You Begin

1. Install the MediByte Software (see Chapter 3).

2. Insert a new battery into the MediByte/MediByte Jr.

3. Ensure the patient is not connected to the MediByte/MediByte Jr.



Preparing the MediByte
2.  Connect the MediByte/MediByte Jr to the Computer

To connect the MediByte/MediByte Jr to the computer:

1.  Connect the large end of the USB cable to the USB port of the computer and connect the 
other end of the USB cable to the MediByte/MediByte Jr.

2.  Double-click the MediByte software icon  on your desktop to start the software. The 

software will automatically detect whether the recorder is a MediByte or MediByte Jr.

3.  Select an Operation in the wizard
The software features a MediByte wizard which guides you through the system settings. Here, 
you will choose whether to configure the MediByte/MediByte Jr for a study, download data or 
review an existing data file.

1. The MediByte wizard requires that you confirm 
that your patient is not connected to the 
MediByte/MediByte Jr by clicking the checkbox. 

•  Click Next to continue.

Do NOT connect the MediByte/MediByte Jr to the computer while it is in 
contact with the patient. This could cause serious injury to the patient.

Figure 4.1:  Opening screen
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Preparing the MediByte
2. In the Operation Selection window, select from 
the list of activities. 

• To prepare for a study, select Configure the Medibyte 
for a Study and click Next to move to the Patient 
screen.

• To retrieve data from the recorder, select Download 
data from the MediByte and click Next to start the 
data download.

• To review a data file stored on the computer, select 
Review Existing Data File and click Next to open the 
Load and Review window to select a data file.

• The Renew MediByte license (Unlimited-use device) 
is inactive because your device has an unlimited 
number of uses. 

4.  Enter Patient Information
In the Patient Information window, enter the patient’s name, identification number and weight. 
Enter this information correctly as the patient file name is created using the patient’s last name 
and ID.

1. Type the patient’s last name in the Last Name 
field. This field is limited to 20 characters.

2. Type the patient’s first name in the First Name 
field. This field is limited to 12 characters.

3. Type the patient’s unique code in the Patient ID 
field. This field is limited to ten characters.

4. Type the patient’s weight in either kilograms or 
pounds. The weight entered determines whether 
the patient is an adult or pediatric patient; i.e., 
greater than 55 pounds (25 kg) is considered 
adult. The default weight is 100 pounds (45 kg).

5. Click Next to move to the next screen. You 
cannot use the Next button to move forward 
until you have entered information into all of the 
fields.

Figure 4.2:  Operation Selection window

Figure 4.3:  Patient information window



Preparing the MediByte
5.  Select an Auxiliary Device (MediByte only)
The MediByte wizard prompts you to select the function of the auxiliary port. Use this screen 
to select the external accessory you want to use for the recording; this is the accessory that 
plugs into the AUX port.

1. Select the auxiliary device from the list and click 
Next to move to the start time screen.

• Snore microphone

• EKG

• EMG Bruxism

• EMG PLM

• Sleep 

• Sleep + EKG* 

• Sleep + EEG*

• Do not use AUX channel

Additional Options:

• Use Airflow Thermistor

• Use CPAP Pressure

As each item is selected, the picture corresponding to the selection changes. 

* These montages require the 8612 Electrode Box SE. You cannot use the thermistor with these 
montages.

If you select Do Not Use AUX, do not select Use Airflow Thermistor.

Figure 4.4: Auxiliary device window
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6.  Select the Start Time
Select whether the recording will start automatically or manually. Automatically means the 
MediByte/MediByte Jr will start recording data at the time specified; the collection on/off 
switch is disabled. Manually means the collection on/off switch is enabled and the patient 
must start the data recording by pushing the collection on/off switch on the MediByte/
MediByte Jr to the right (white dot). 

1. Select either the automatic or manual start. If 
you select automatic, you must select the start 
date and time. 

2. Select either a one-night or two-night study and 
click Next to move forward to the summary 
screen. If you have opted to perform an EKG 
study, you will also have the option to select a 
24-hour study.

For a successful two-night recording, select automatic mode. This mode 
preserves battery power.

Figure 4.5: Select the start time



Preparing the MediByte
7.  Review the Settings And Configure the MediByte
The Summary screen permits you to review the settings before you configure the MediByte/
MediByte Jr. If the settings are correct, start the configuration by clicking Next. If you need to 
change one of the settings, use the Back button to return to the previous screens.

1. Review the summary screen. If the settings are 
correct, click Next. The software will confirm that 
you have finished and it is ready to configure the 
recorder. 

2. Select Finish. The software will send the patient 
information and study settings to the recorder. 
This action is called configuring the MediByte/
MediByte Jr. Once the recorder is configured, the 
software closes automatically and you can 
disconnect the recorder from the computer.

The MediByte/MediByte Jr is now ready to 
record a study.

When you configure the MediByte/MediByte Jr,, the software sends the patient 
information and study settings to the recorder. You must configure the recorder before 
you start a study.

Figure 4.6: Summary screen

Figure 4.7: Final screen
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Preparing the MediByte
8.  Prepare a MediByte Kit for the Patient
The MediByte Jr Kit has all items required for a study. For the MediByte, pack the kit with only 
the sensors the patient requires to perform the study.

Study type Requirements

No Aux (Cannula Study) 

MediByte
2 RIP Belts with cables
SpO2 Cable

Patient Kit

Snore

MediByte
2 RIP Belts with cables
SpO2 Cable

Snore Microphone
Patient Kit

EKG

MediByte
2 RIP Belts with cables
SpO2 Cable

Electrode Box
3 EKG Leadwires (24”)
Electrode Prep Kit

BRUX or SLEEP 

MediByte
2 RIP Belts with cables
SpO2 Cable

Electrode Box
4 EKG Leadwires (24”)
Electrode Prep Kit

PLM

MediByte
2 RIP Belts with cables
SpO2 Cable

Electrode Box
4 EKG Leadwires (60”)
1 EKG Leadwire (24”)
Electrode Prep Kit

SLEEP + EKG or 
SLEEP +EEG

MediByte
2 RIP Belts with cables
SpO2 Cable

Electrode Box SE
5 EKG Leadwires (24”)
Electrode Prep Kit



Chapter 5: Preparing the Patient

In this chapter
This chapter describes how to place the sensors on the patient, where to plug the sensors into 
the MediByte/MediByte Jr, how to begin and how to end a study.

This chapter includes:

• MediByte Jr study

• RIP Belt for MediByte

• SpO2 Cable for MediByte 

• Cannula

• CPAP pressure study (MediByte Jr)

• Snore study (MediByte)

• Chest and abdominal RIP Belts

• Snore microphone

• Cannula placement or

• Cannula with thermistor placement 

• SpO2 Cable for MediByte 

• Auxiliary channel electrode placement (MediByte)

• EKG study

• EMG Bruxism study

• EMG PLM study

• Sleep study

• Sleep + EKG study

• Starting the study

• Ending the study
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Preparing the Pa-
MediByte Jr Study
The MediByte Jr study uses a cannula, RIP Belt for MediByte and an SpO2 Cable for MediByte.

Preparing for a MediByte Jr study is so easy the patient can usually do it at home.

Figure 5.1: MediByte Jr study



Preparing the Patient
1. Place the Chest RIP Belt 
The chest RIP Belt clips onto the MediByte Jr, as illustrated. 

1. With the MediByte Jr upright and facing 
you, clip the black belt onto the right 
MediByte Jr clip.

2. Tighten the belt as much as possible; it is 
much easier to loosen a tight belt on the 
body than to tighten a loose belt.

3. Wrap the belt around the chest and clip 
into the remaining MediByte Jr clip. 

4. Ensure the belt is located above or below 
the patient’s nipple line and loosen for a firm but comfortable fit.

5. Take the Y-shaped black cable and plug one safety pin connector into the left socket located 
on the belt and the other safety pin connector into the right socket.

6. Use medical tape to tape down the wires, if desired.

7. Plug the keyhole connector into the black keyhole input on the bottom right (when wearing) 
of the MediByte Jr, labelled CHEST.

Figure 5.2: Placement of the chest RIP Belt 
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Preparing the Pa-
Place the cannula (MediByte Jr): 

1. Position the nasal prongs in the patient’s 
nostrils and wrap the tubes over the ears and 
under the chin. 

2. Using medical tape, secure the tubes to the 
patient’s face.

3. Adjust the slider for a comfortable fit under 
the chin.

4. On the MediByte Jr, screw the filter on the end 
of the cannula to the input marked PRESSURE. 
Do NOT overtighten the filter.

Figure 5.3: Pressure cannula placement

Figure 5.4: Connect the pressure filter to the Pressure 
cannula connection



Preparing the Patient
Place the SpO2 Cable for MediByte (MediByte Jr)

1. Place the cleaned middle finger 
(recommended) into the silicone pouch. Align 
the light-emitting sensor over the nail bed. The 
tip of the finger must not go through the end of 
the pouch.

2. Tape the sensor cable with medical tape after 
the second knuckle; ensure the finger can bend 
freely and movement is not restricted.

3. On the MediByte Jr, slide the sensor connector 
into the input marked SpO2, ensuring the red 
dot on the connector aligns with the red dot on 
the SpO2 input. 

Remove artificial nails and nail polish from the chosen finger before you begin. 

Figure 5.5: Using the SpO2 Cable for MediByte

Ensure the red dot on the finger probe connector is aligned with the red dot on the 
MediByte Jr. Do NOT twist the connector; it will move easily in and out of the port 
once the dots are aligned. Give the connector a light tug to ensure that it is fully 
connected and will not come loose during the night.

Figure 5.6: Connect the sensor to the SpO2 port

Maximum application time for a 
site (finger) is nine hours.
  5-5



5-6  

Preparing the Pa-
CPAP Pressure Study (MediByte Jr)
For a CPAP Pressure study, the patient wears 
CPAP headgear attached to the MediByte Jr 
with CPAP pressure tubing and the SpO2 
sensor. The following page illustrates how to 
attach the MediByte to CPAP Adapter (Model 
8552) to the CPAP headgear. To place the 
SpO2 sensor onto the patient, see page 5-5.

Preparing for a CPAP Pressure study is so 
easy that usually the patient can do this at 
home.

Figure 5.7: CPAP study



Preparing the Patient
 Attach the CPAP Pressure tubing: 

1. Position the CPAP mask on the patient. The 
diagram illustrates a generic CPAP mask, your 
mask may look different. 

2. Attach the MediByte to CPAP Adapter (Model 
8552) to the CPAP output nozzle.

3. On the MediByte Jr, screw the filter end of the 
MediByte to CPAP Adapter (Model 8552) to 
the input marked PRESSURE. Do NOT 
overtighten the filter.

Alternative attachment: attach pressure 
tubing to the nipple port on the CPAP mask 
(shown). Alternatively, you can attach the 
MediByte to CPAP Adapter (Model 8552) to an 
inline adapter.

Figure 5.8: Connect the MediByte to CPAP Adapter 
(Model 8552) to the CPAP output nozzle

Figure 5.8: Connect the CPAP pressure tubing to 
the Pressure connection

Figure 5.8: Alternative attachment
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Snore Study (MediByte)

Figure 5.9: Snore study



Preparing the Patient
Chest and Abdominal RIP Belts
The chest and abdominal RIP Belts record respiratory effort. 

To place the chest RIP Belt
The chest RIP Belt clips onto the MediByte 
as illustrated. 

1. With the MediByte upright and facing 
you, clip the black belt onto the right 
MediByte clip.

2. Tighten the belt as much as possible; it is 
much easier to loosen a tight belt on the 
body than to tighten a loose belt.

3. Wrap the belt around the chest and clip 
into the remaining MediByte clip. 

4. Ensure the belt is located above or below the patient’s nipple line and loosen for a firm but 
comfortable fit.

5. Take one of the Y-shaped black cables and plug one safety pin connector into the left socket 
located on the belt (circled) and the other safety pin connector into the right socket (circled).

6. Use medical tape to tape down the wires, if desired.

7. Plug the keyhole connector into the black keyhole input on the bottom right of the MediByte 
labelled CHEST.

Figure 5.10: Placement of the chest RIP Belt
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Preparing the Pa-
To place the abdominal RIP Belt
The abdominal RIP Belt is placed below the 
rib cage.

1. As with the chest RIP Belt, tighten the 
belt as much as possible before putting it 
on. 

2. Wrap the belt around the patient’s 
abdomen and snap closed. Loosen for a 
firm but comfortable fit.

3. Take the remaining black Y-shaped cable 
and plug one safety pin connector into 
the left socket located on the belt and 
the other safety pin connector into the 
right socket.

4. Use medical tape to tape down the wires, 
if desired.

5. Plug the keyhole connector into the black 
keyhole input on the bottom left of the 
MediByte labelled ABDOMEN.

Figure 5.11: Placement of the abdominal RIP Belt



Preparing the Patient
Snore Microphone
The Snore Microphone collects snoring sounds.

1. Position the Snore Microphone on the 
patient’s forehead or cheek. 

2. Secure the Snore Microphone with medical 
tape.

3. Plug the Snore Microphone into the AUX 
port on the MediByte, ensuring the red 
mark on the connector lines up with the red 
mark on the port (circled). 

4. If you are using a cTherm cannula 
thermistor, plug the connector from the 
cTherm cannula thermistor into the white 
connector on the Snore Microphone. See 
page 5-13 for placing the cTherm cannula 
thermistor.

Figure 5.12: Snore Microphone placement

Figure 5.13: Connect the Snore Microphone to AUX.
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Cannula Placement
The cannula measures airflow. 

1. Position the nasal prongs in the patient’s 
nostrils and wrap the tubes over the ears and 
under the chin. 

2. Using medical tape, secure the tubes to the 
patient’s cheeks.

3. Adjust the slider for a comfortable fit under 
the chin.

4. On the MediByte screw the filter on the end of 
the cannula to the input marked PRESSURE. 
Do NOT overtighten the filter.

Figure 5.14: Pressure cannula placement

Figure 5.15: Connect the pressure filter to the 
Pressure cannula connection



Preparing the Patient
Cannula with Thermistor Placement
The cannula and thermistor both measure 
airflow.

1. Position the cTherm cannula thermistor onto 
the cannula so that the cTherm cannula 
thermistor will be facing toward the patient. 
In other words, the cTherm cannula 
thermistor is behind the cannula when 
applied to the patient.

2. Position the nasal prongs in the patient’s 
nostrils, the cTherm cannula thermistor 
mouth-piece is on the inside, closest to the 
mouth.

3. Gently grasp the cannula tubing and cTherm  
cannula thermistor wires together, and wrap 
them over the ears and under the chin.

4. Adjust the sliders on both the cannula and the 
cTherm cannula thermistor for a comfortable 
fit under the chin.

5. On the MediByte screw the filter on the end 
of the cannula to the input marked 
PRESSURE. Do NOT overtighten the filter.

6. The cTherm cannula thermistor plugs into the 
Snore Microphone.

Figure 5.16: Pressure cannula with thermistor

Figure 5.17: Connecting the pressure cannula and 
thermistor

Figure 5.18: cTherm placement on the cannula
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SpO2 Cable for MediByte

1. Place the cleaned middle finger 
(recommended) into the silicone pouch. Align 
the light-emitting sensor over the nail bed. The 
tip of the finger must NOT go through the end 
of the pouch.

2. Tape the sensor cable with medical tape after 
the second knuckle. Ensure the finger can bend 
freely and movement is not restricted.

3. On the MediByte, slide the sensor connector 
into the input marked SpO2, ensuring the red 
dot on the connector aligns with the red dot on 
the SpO2 input. 

Remove artificial nails and nail polish from the chosen finger before you begin. 

Figure 5.19: Using the SpO2 Cable for MediByte

Ensure the red dot on the finger probe connector is aligned with the red dot on 
the MediByte. Do NOT twist the connector; it will move easily in and out of the 
port once the dots are aligned. Give the connector a light tug to ensure that it 
is fully connected and will not come loose during the night.

Figure 5.20: Connect the sensor to the SpO2 port

Maximum application time for 
a site (finger) is nine hours.



Preparing the Patient
Using a FlexiWrap SpO2 Cable for MediByte

1. With the FlexiWrap face down on the table, pull up the tab and 
peel away the paper backing. The FlexiWrap has cutouts that fit 
over the finger sensor.

• Insert the sensor into the cutouts in the FlexiWrap.

2. Place the index finger on the sensor so the dotted line on the 
FlexiWrap is at the tip of the finger.

• Wrap the small side flaps around the side of the finger.

3. Fold the FlexiWrap over the top of the index finger so the raised 
parts of the sensor are vertically aligned.

• Wrap the small side flap around the side of the finger.

4. Wrap the long flap around the finger.

• Around the base of the index finger, tape the sensor cable with 
medical tape.

5. Use medical tape to secure the leads on the patient’s arm. If the 
patient is wearing a long-sleeve top, you can run the cable up 
the sleeve and out of the neck hole, foregoing the tape.

Do not wrap the FlexiWrap around the finger too tightly or you may 
restrict blood flow.

Figure 5.21: FlexiWrap and sensor

Figure 5.22: Finger on the sensor

Figure 5.23: Fold and wrap 

Figure 5.24: Wrap the long flap
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EKG Electrode Placement
The EKG electrode assembly uses peel and snap electrodes which plug into the Electrode Box 
(Model 8611). The Electrode Box is plugged into AUX on the MediByte.

To use peel and Snap electrodes:

1. Plug the leadwires, according to their color, 
into the Electrode Box.

2. Abrade the area with an alcohol wipe for ten 
seconds and allow the area to dry.

3. Peel the back off the adhesive pad and apply 
the pad to the abraded area.

4. Snap the electrode to the adhesive pad.

Figure 5.25: Peel and snap electrode

Figure 5.26: Electrode Box connected to AUX



Preparing the Patient
To use the EKG electrode assembly

1. Place one adhesive pad on the left rib cage 
and attach the black electrode to the pad.

2. Place one adhesive pad on the right shoulder 
and attach the red electrode to the pad.

3. Place one adhesive pad on the left shoulder 
(this is the ground) and attach the green 
electrode to the pad.

4. Plug the leadwires according to their color 
into the Electrode Box.

5. Plug the lead of the Electrode Box into the 
AUX port on the MediByte ensuring the red 
dot on the connector is aligned with the red 
dot on the port.

6. If you are using the cTherm cannula 
thermistor, plug the connector from the 
cTherm into the white port located on the 
bottom of the Electrode Box.

Figure 5.27: EKG electrode placement
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Bruxism Electrode Placement
The Bruxism electrode assembly uses four peel and snap electrodes which plug into the 
Electrode Box (Model 8611). The Electrode Box is plugged into AUX on the MediByte. To use the 
peel and snap electrodes, see page 5-16.

To use the Bruxism assembly

1. To locate the temporalis, ask the 
patient to lightly clench the jaw and 
place an adhesive electrode pad at the 
peak of the muscle bulge; 1 on the 
diagram.

• Attach a black electrode to the pad.

2. Attach an adhesive electrode pad to 
the Zygomatic arch (cheekbone); 2 on 
the diagram.

• Attach a red electrode to the pad.

3. To locate the masseter, ask the patient 
to lightly clench the jaw and place an 
adhesive electrode pad at the peak of 
the muscle bulge; 3 on the diagram.

• Attach a black electrode to the pad.

4. Attach an adhesive electrode pad to 
the Mastoid process; 4 on the diagram.

• Attach the green electrode to the 
pad. This is ground.

5. Plug the leadwires according to their 
color into the Electrode Box.

6. Plug the lead of the Electrode Box into 
the AUX port on the MediByte ensuring 
the red dot on the connector is aligned 
with the red dot on the port.

Figure 5.28: Bruxism assembly placement (leads not shown)

1

2

3 4



Preparing the Patient
PLM Electrode Placement
The PLM electrode assembly uses peel and snap electrodes which plug into the Electrode Box 
(Model 8611). The Electrode Box is plugged into AUX on the MediByte. To use the peel and snap 
electrodes, see page 5-16.

To use the PLM electrode assembly:

1. On the right foreleg, place one adhesive 
pad and attach a red electrode to the pad.

2. Place a second adhesive pad 2” (5 cm) 
above the first, and attach a black 
electrode to the pad.

3. Repeat for the left leg.

4. Place the one adhesive pad on the left 
shoulder (this is ground) and attach the 
green electrode to the pad.

5. Plug the leadwires according to their color 
into the Electrode Box.

6. Plug the lead of the Electrode Box into the 
AUX port on the MediByte ensuring the 
red dot on the connector is aligned with 
the red dot on the port.

7. Tape down the loose leadwires.

Figure 5.29: PLM study sensor placement; wires under shorts
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Sleep Study Electrode Placement
The Sleep Study electrode assembly uses four peel and snap electrodes which plug into the 
Electrode Box (Model 8611). The Electrode Box is plugged into AUX on the MediByte. To use the 
peel and snap electrodes, see page 5-16.

To use the Sleep Study assembly

1. Place an adhesive electrode pad on FPz 
location of the center of the forehead.

• Attach a black electrode to the pad.

2. Place an adhesive electrode pad on E1 (left 
eye 1 cm outer canthus, 1 cm inferior).

• Attach a red electrode to the pad.

3. Place an adhesive electrode pad on the chin.

• Attach a red electrode to the pad.

4. Attach an adhesive electrode pad on M1, the 
mastoid process.

• Attach the green electrode to the pad. This 
is ground.

5. Plug the leadwires according to their color 
into the Electrode Box.

6. Plug the lead of the Electrode Box into the 
AUX port on the MediByte ensuring the red 
dot on the connector is aligned with the red 
dot on the port.

Figure 5.30: Sleep Study electrode placement



Preparing the Patient
Sleep + EKG
The Sleep + EKG Study electrode assembly uses five peel and snap electrodes which plug into the 
optional Electrode Box SE (Model 8612). The Electrode Box SE is plugged into AUX on the 
MediByte. To use the peel and snap electrodes, see page 5-16.

To use the Sleep + EKG assembly

1. Place an adhesive electrode pad on the FPz 
location of the center of the forehead.

• Attach a red electrode to the pad.

2. Place an adhesive electrode pad on E1 (left eye 
1 cm outer canthus, 1 cm inferior).

• Attach a black electrode to the pad.

3. Place an adhesive electrode pad on the chin.

• Attach an red electrode to the pad.

4. Place an adhesive pad on M1, the mastoid 
process.

• attach a green (ground) electrode to the 
pad.

5. Place an adhesive pad on the left or right rib 
cage.

• attach the orange electrode to the pad.

6. Plug the leadwires according to their color into 
the Electrode Box SE.

7. Plug the lead of the Electrode Box SE into the 
AUX port on the MediByte ensuring the red 
dot on the connector is aligned with the red 
dot on the port.

Figure 5.31: Sleep + EKG electrode placement
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Sleep + EEG
The Sleep + EEG Study electrode assembly uses five peel and snap electrodes which plug into the 
optional Electrode Box SE (Model 8612). The Electrode Box SE is plugged into AUX on the 
MediByte. To use the peel and snap electrodes, see page 5-16.

To use the Sleep + EEG assembly

1. Place an adhesive electrode pad on the FPz 
location of the center of the forehead.

• Attach a red electrode to the pad.

2. Place an adhesive electrode pad above the 
left eyebrow.

• attach the orange electrode to the pad.

3. Place an adhesive electrode pad on E1 (left 
eye 1 cm outer canthus, 1 cm inferior).

• Attach a black electrode to the pad.

4. Place an adhesive electrode pad on the chin.

• Attach a red electrode to the pad.

5. Place an adhesive pad on M1, the mastoid 
process.

• attach a green (ground) electrode to the 
pad.

6. Plug the leadwires according to their color 
into the Electrode Box SE.

7. Plug the lead of the Electrode Box SE into the 
AUX port on the MediByte ensuring the red 
dot on the connector is aligned with the red 
dot on the port. 

Other 10-20 EEG electrode locations may be used, but will require use of 
different electrode application techniques.

Figure 5.32: Sleep + EEG electrode placement



Preparing the Patient
Starting the Study
Once the patient is wearing all of the sensors and the leads are connected to the MediByte/
MediByte Jr, the recorder is ready to collect data. If the recorder is set to automatic start 
(recommended), it will start on its own at the designated start time. If the recorder is set to 
manual start, instruct the patient to slide the collection on/off switch to the ON position (white 
dot) at bedtime. Manual start is not recommended.

The event button is used to mark significant events during the night. For example, instruct the 
patient to press the event button when turning off the lights, when getting up in the middle of 
the night, upon returning to bed, etc. The data will contain a button press marker which will 
display on the screen during data analysis.

Ending the Study
In the morning, instruct the patient to push the Event button, slide the collection on/off switch 
to the OFF position and remove the sensors. 

The unit is now ready for data retrieval.
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Chapter 6: Reviewing Data

In this chapter

This chapter describes how to download data from the MediByte/MediByte Jr, review the 
displayed data, mark it with event tags, mark it with scoring tags, adjust the event tags and 
scoring tags and print a report. You cannot open the data display screen without data either 
stored on your computer or downloaded from the MediByte/MediByte Jr.

This chapter includes:

• Downloading data from the MediByte/MediByte Jr

• Data display screen

• Changing the language used in the software

• Reviewing the data

• Assisted Scoring of events

• Manual Scoring of events

• Printing reports
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Reviewing Data
Downloading Data from the MediByte/MediByte Jr 

1. If you have not already done so, 
disconnect the MediByte/MediByte Jr 
from the patient.

2. Ensure the battery is still functioning (the 
status LED will flash green once every six 
seconds).

3. Plug the USB cable into the computer and 
then into the MediByte/MediByte Jr.

4. Double-click the MediByte software icon 
on your desktop to start the software.

5. In the Operation Selection window, select 
Download data from the MediByte. An 
information window will appear to inform 
you that data has been found and the 
MediByte is downloading.

• The scoring assist feature will process 
the data and generate scoring events.

• The final screen of the wizard appears 
when the data download is finished. 
The screen displays the following: 
Please ensure the data is reviewed by a 
qualified professional. 

6. Click Finish. The software will display the 
data on the computer screen.

Do NOT connect the MediByte/MediByte Jr to the computer while it is in 
contact with the patient. This could cause serious injury to the patient.

Figure 6.1: Select Download data from the MediByte

Figure 6.2: Downloading data window



Reviewing Data
Open a New Data File
You can open another data file from within the Data Display screen. When you open the new 
file, the current file is replaced. You cannot have two data files open at the same time.

To open a new data file:

1. Click File>Open to activate the Studies Data 
Manager. The Studies Data Manager displays 
the available files in the Default Tests Folder.

2. To select a different storage folder, click the 

dropdown button  and select a new folder.

3. Double-click the data file you wish to open; the 
new file opens in the Data Display screen.

Figure 6.3: Studies Data Manager
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Open a Study without the MediByte 
You can open a study without connecting the MediByte to the computer. 

To open a study:
1. Double-click the MediByte icon on the desktop. 

2. Type the password MASTER into the Password 
field. The password is case-sensitive and must 
be typed in upper case (capitals).

3. Click the Analyze a study button to open the 
Load and Review window. 

4. Double-click on the study you want to review. 
Alternatively, click to highlight the study and 
click Finish. The Data Display screen will open 
with the selected study displayed.

Figure 6.4: Opening screen

Figure 6.5: Load and Review window with a data 
file selected



Reviewing Data
Data Display Screen
MediByte software uses a standard Microsoft® Windows® graphical user interface (GUI) with a 
toolbar, status bar, and drop-down menus.

Figure 6.6:  Data Display screen

Patient information

View the histogram

Open the event 
markers window

Scale the display

Delete a 
scoring marker

Print a report

Print current screen

Restore a deleted 
marker

On-screen buttons

Mark bad data 

Mark and play 
audio

Audio FFT Analysis

Record observations
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Reviewing Data
Changing the Language Used in the Software
You can change the language from within the Data Display Screen. The following languages are 
available within the software: Arabic, Chinese, German, English, Spanish, French, Italian, Dutch, 
Polish, Portuguese, Romanian and Russian.

To change the language used in the software:

1. Click Tools>Language to open the language selection menu.

2. Click on a language to change the language used in the software. It is best to restart the 
software to ensure all fields and windows are translated.

Figure 6.7: Language selection menu



Reviewing Data
Reviewing the Data
The MediByte software automatically tags the data with scoring events. Review the suggested 
scoring tags by paging through the data or by viewing the histogram. 

To review screens of data:

•   or  move forward through the data by one full screen.

•   or  +  move forward through the data by half a screen.

•   or  move backward through the data by one full screen.

•   or  +  move backward through the data by half a screen.

•   moves to the first screen.

•   moves to the last screen.
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Reviewing Data
Reviewing Data with the Histogram
You can review the data using the histogram. 

To jump to a screen of data from the histogram:

1. Expand the histogram by dragging the upper 
boundary of the histogram (circled).

1. Point to the section of the histogram you want 
to see in greater detail (as above) and click. The 
main data display shows the selected area of 
data.

Figure 6.8: Click on the histogram to view the data in greater detail

Figure 6.9: Drag the upper boundary of the 
histogram to expand it.



Reviewing Data
Changing the properties of the histogram
You can select the type of data you wish to see on the histogram using the Histogram Settings 
window.

To change the histogram properties:

1. Right-click on the histogram to activate the Histogram Info Properties button.

2. Click the Histogram Info Properties button to open the Histogram Settings window.

3. Select the Waveform Type, Signal, Lower and Upper Units and whether you want to see a 
Label.

4. Click OK.

Figure 6.10: Histogram Settings window
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Reviewing Data
Using the Study Navigator
The study navigator is located below the Data Display screen. Use it to search through the data 
using one of the following parameters: time, signal or scored event.

Navigating by Time
This function searches for a specific time in the study. You can set the constraint to time of day 
or time into the study.

1. Click the Search for button and select Time.

2. Click the hour section to highlight and press the arrows  to change the hour.

3. Click the minute section to highlight and press the arrows  to change the minutes.

4. Select the constraint; i.e., time of day or time into study. 

5. Select the search forward  or search backward  button.

Navigating by Signal
This function searches for a specific signal in the study. You can set the constraint relative to a 
percentage value of the signal, the minimum value or the maximum value of the signal.

1. Click the Search for button and select Signal.

2. Click the arrow  to select the signal type.

3. Select the constraint . If you entered a relational constraint (for example, =), enter the 
percentage value.

4. Select the search forward  or search backward  button.

Figure 6.11: Navigating by Time

Figure 6.12: Navigating by Signal



Reviewing Data
Navigating by Scored Event
This function searches for a specific scored event in the study.

1. Click the Search for button and select Scored Event.

2. Click the arrow  to select the scored event type.

3. Select the constraint.

4. Select the search forward  or search backward  button.

Figure 6.13: Navigating by Scored Event
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Reviewing Data
Study Status Bar
The study status bar is located below the study navigator. The study status bar provides the 
following information:

1. Signal measurement: shows the quantitative measure of a signal as you move the mouse 
over it. 

2. Study status: For studies collected using version 9 software: UNVALIDATED means the study 
has been scored by the software, but not by a human. VALIDATED means that every epoch 
between lights off and lights on has been reviewed and at least one event has been altered.
For studies collected from previous versions of the software, they will initially display as 
UNVALIDATED even if they had been reviewed in the previous version. After the Sleep Tech’s 
name and observations have been entered into the study, the status will switch to 
VALIDATED.

3. Arousal Index (AI): average number of arousals per hour. AI is only reported on a study that 
recorded sleep; i.e., Sleep, Sleep + EEG or Sleep + EKG.

4. Apnea Hypopnea Index (AHI): average number of apnea and hypopnea events per hour of 
sleep. This number displays in green when the AHI is less than 15, yellow between 15 and 30 
and red when the AHI is greater than or equal to 30.

5. RDI: average number of episodes of apneas, hypopneas and RERAs per hour of sleep. This 
number displays in green when the RDI is less than 20, yellow between 20 and 40 and red 
when the RDI is greater or equal to 40.

6. Good Data: displays the number of minutes of good data in the study.

7. Epoch number: displays the epoch number as epoch number of total number of epochs.

8. Page Width: displays the page width in seconds.

Figure 6.14: Study Status Bar
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Lights Out/Lights On Tags
The MediByte software automatically adds LIGHTS OUT/ LIGHTS ON tags during the initial 
downloading of the data from the MediByte. The software tags the data with a LIGHTS OUT tag 
after the first ten minutes of stable, non-standing data where the SpO2 is also stable and valid. 

The software tags the data with a LIGHTS ON tag by moving back from the end of the data set to 
the first five minutes of stable, non-standing data where the SpO2 is also stable and valid.

Before you begin the data review, ensure that the data has been tagged with LIGHTS OUT and 
LIGHTS ON tags. If the patient pressed the Event button on the MediByte at bedtime and 
waking, there will be button press tags in the data. Insert the LIGHTS OUT and LIGHTS ON tags 
where button press tags are located and then remove the tags inserted by the software. See 
“Deleting Event Markers” on page 6- 20.

To tag the data:

1. At the beginning of the data set, double-click the 
data to activate the Select a User Event window.

2. Click the LIGHTS OUT button to place a Lights Out 
tag in the data.

3. At the end of the data set, double-click the data 
to activate the Select a User Event window.

4. Click the LIGHTS ON button to place a Lights On 
tag in the data.

Figure 6.15: Select a User Event window
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Patient Information
You can open the Patient Info screen and add additional information about the patient. Since 
the MediByte wizard only accepts the first name, last name, patient ID and weight, you will likely 
require more information about the patient. 

To review and add patient information

1. Click  to open the Patient Info window.

2. In the Code field, type a unique patient code, 
as required.

3. In the Last Name and First Name field, verify 
the names are correct.

4. In the SOC/SIN field, type the patient’s Social 
Security Number (SOC)/Social Insurance 
Number (SIN).

5. In the DOB (Date of Birth) field, click the part 
of the date you want to change, and then type 
the month, date or year of your choice.

6. In the Height field, type the patient’s height in 
either feet (ft.) and inches (in.) or centimeters 
(cm) using whole numbers. The software 
calculates the corresponding value.

7. In the Weight field, type the patient’s weight 
in either pounds (lbs.) or kilograms (kg) using 
whole numbers. The software calculates the 
corresponding value. 
Once you have entered the height and weight 
values, the MediByte software calculates the 
body mass index (BMI).

8. In the Neck Circumference field, enter the 
patient’s neck circumference in either feet (ft.) 
and inches (in.) or centimeters (cm) using 
whole numbers. The software calculates the 
corresponding value.

Figure 6.16: Patient Info Screen
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9. In the Waist field, enter the patient’s waist measurement either in inches (in.) or 
centimeters (cm) using whole numbers. The software calculates the corresponding value.

10. In the Hip field, enter the patient’s hip measurement either in inches (in.) or centimeters 
(cm) using whole numbers. The software calculates the corresponding value. Once you have 
entered the waist and hip measurements, the MediByte Software calculates the waist-hip 
ratio.

11. Click Male or Female.

12. In the Referring Physician field, type the referring doctor’s name, if required.

13. In the Medications field, type all the medications the patient uses.

14. Click Save and then click OK to save the patient file.

*Lancet, 2005 November; 366 (9497) 1640-9; Obesity and the risk of myocardial infarction on 27,000 
participants from 52 countries: a case-control study. Yusuf, Hawken et al.

Table 6-1: Waist to Hip Ratio Chart*

Male Female
Health Risk 
Based Solely 
on WHR

  Low risk

  Moderate Risk

  High Risk
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Scaling the Display
When the data is first displayed on the screen, the waveforms may appear flat. You can scale the 
display to improve the appearance of the waveforms. Scaling takes the maximum and minimum 
values of the waveforms and adjusts the upper and lower limits of the waveforms 
proportionally. Scaling changes the appearance of the display, it does not change the data.

To scale the display:

• Click  to scale the display. The figure at 

right shows the same data display before and 
after scaling.

Figure 6.17: Data before and after scaling 
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Changing the Appearance of a Signal
You can change the way a signal is displayed on the screen using the 
signal properties menu. In the signal properties menu you can select 
scale, invert, digital and color. Changing the appearance of the signal 
using the signal properties menu does not change the data, only the 
way it is displayed on the screen.

To scale a channel:

1. Right-click on a channel to open the signal 
properties menu.

2. Click Scale to select the channel for scaling.

3. Click .

To invert a channel:

1. Right-click on a channel to open the signal 
properties menu.

2. Click Invert to invert the channel.

To display the digital readout of a channel:

1. Right-click on a channel to open the signal 
properties menu.

2. Click Digital to display the digital readout of the 
channel.

To change the color of the channel:

1. Right-click on a channel to open the signal properties menu.

2. Click Color to open the color menu.

3. Click on a color and select OK.

Figure 6.18: Signal 
properties menu of 
the Pulse channel

Figure 6.19: Signal before and after scaling

Figure 6.20: EKG before and after inverting

Figure 6.21: EKG digital readout
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To see the actual time on the display

1. Right-click on a channel to open the signal 
properties menu.

2. Click Time and the actual time of the recording is 
shown at the bottom of the display.

To change the sensitivity of a channel:

1. Hold the control key and double-click the left 
mouse button. The signal will turn yellow.

2. Use the up and down arrow keys or your mouse 
wheel to change the amplitude of the signal. The 
data itself will not change, just how you see it on 
the screen.

3. When you are satisfied with the appearance of the 
signal, click the display and the signal will return to 
black.

Figure 6.22: Flow before and after changing the 
sensitivity
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Jumping to Event Markers
View a list of event markers in the Event Markers window. Double-click on an event marker to 
jump to the screen to view the event in greater detail. 

To jump to an event marker:

1. Click  to open the Event Markers window.

2. Double-click the appropriate event marker in the list to 
jump to the epoch with the selected event marker. 

Inserting User Event Markers
While reviewing a study, you can insert additional event markers by double-clicking on the data 
and inserting a new user event. The MediByte Software inserts a vertical line and the user event 
tag in the data. If you have a CPAP study, you can insert a CPAP pressure tag.

To insert an event marker:

1. Go to the epoch where you want to insert a user event.

2. Position the mouse over an empty (white) part of the 
display and double-click to open the Select a User Event 
window.

3. Click to select the appropriate user event button or type a 
user event description and click Select. 

To insert a CPAP pressure tag:

1. Go to the epoch where you want to insert a CPAP pressure 
tag.

2. Position the mouse and double-click to open the Select a 
User Event window.

3. Click the up and down arrows to select the appropriate 
pressure level. Click CPAP. CPAP tags are only available in 
studies where a CPAP signal was recorded.

Figure 6.23:  Event markers window

Figure 6.24: Select a user event window

Figure 6.25: Select a CPAP user event
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Deleting Event Markers
You can delete unwanted event markers from a study. Instead of searching through data to look 
for event markers you want to delete, use the event markers window to delete any event 
markers you don’t want.

To delete an event marker:

1. Click  to open the Event Markers window.

2. Select the event you want to delete from the list.

3. Right-click on the event in the list to activate the event 
filter settings.

4. Click Delete.

Figure 6.26: Deleting an 
event marker
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Enter Observations
Use the Observations\Comments window to enter notes about the patient. The Night 
technician, Scoring technician and Physician can all add comments to the record.

To enter an observation:

1. Click  to open the 
Observations\Comments window.

2. Use the tabs to select your job title.

3. Type in your observations and click OK.

Figure 6.27:  Observations\Comments window
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View the Photoplethysmograph Signal
You can display the collected photoplethysmograph (PPG) signal by selecting 
photoplethysmograph signal from the View pull-down menu. The PPG signal is a volumetric 
measurement of the blood within the subcutaneous vessels of the finger tip or earlobe, 
depending on which site is used for the MediByte recording (i.e., fingertip SpO2 Cable for 

MediByte or earlobe SpO2 Cable for MediByte). The MediByte pulse oximeter collects the signal 

by illuminating the skin with infrared light. Blood is pumped throughout the body and to the 
periphery with each cardiac cycle. The pressure pulse, though dampened, is sufficient when it 
reaches the periphery to distend the subcutaneous vessels beneath the skin. As shown in Figures 
6.28 and 6.29, premature ventricular contractions (PVCs) may be easily detectable within the 
PPG waveform and the PPG may be useful to detect some cardiac arrhythmias when not using 
the MediByte EKG montage.

• To view the photoplethysmograph signal, click 
View>photoplethysmograph Signal.

The signal is drawn at the bottom of the data 
display.

Figure 6.28: PVC on the PPG signal and the EKG

Figure 6.29: PVC on PPG, Pulse and EKG
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Assisted Scoring of Events
The MediByte software has an assisted scoring tool for automatically tagging the data with bad 
SpO2/pulse data, desaturation, respiratory, RERAs, and upper airway resistance. In addition, 

data collected with the MediByte may also display pulse rate variability, EKG, bruxism and limb 
movement event tags. 

When the software downloads the data file, it automatically scores the events with scoring 
event markers. The scoring event markers are colored bars with scoring event abbreviations in 
the top right corners of the bars. If you have a CPAP study, the software will automatically tag 
CPAP pressure changes after downloading the data. 

You can use the Tools menu to delete the scoring event markers, change the rules for scoring 
and rescore the data.

For information about marking bad SpO2/pulse, see Marking Bad Data on page 6- 43.

Figure 6.30: Scored events (SSD, SNR and hypopnea)
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Changing the Assisted Scoring Rules
Use the Assisted Rules Setup window to change the assisted scoring rules. If you are satisfied 
with the way the software scores the data, leave this window alone. You can change the 
parameters for desaturations, respiratory events, pulse rate variability, upper airway resistance 
events, and limb movements.

To change the assisted scoring settings:

1. Select Tools>Assisted Scoring Settings to open the Assisted Rules Setup screen.

2. Set the conditions for scoring events:

• For Desaturation, set the minimum decline in the signal required to score the event as a desaturation.

• For Respiratory Events, set the minimum duration of an event; the minimum flow reduction required 
to score an apnea and a hypopnea; and the minimum effort reduction required to score an apnea and 
a hypopnea. You can also select to autoscore RERA (respiratory effort related arousal).

• For Pulse Rate Variability (MediByte only), set the minimum required change in beats per minute; 
the minimum and maximum duration of the event.

• For Upper Airway Resistance Events: Snoring (Audio), Snoring (Flow) and Flow Limitation, set the 
lower limit of the Snore volume in dB, set the Snore duration and use the slider to adjust the 
sensitivity of the threshold detector to score more or less events.

• For Limb Movement (MediByte only), set the maximum time between movements to score as both, 
select the channels to be used to detect limb movements and use the slider to adjust the sensitivity of 
the threshold detector to score more or less events.

3. Click OK.
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Figure 6.31: Assisted Rules Setup screen
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Starting the Assisted Scoring
The assisted scoring tool will automatically tag the data with bad SpO2/pulse data, desaturation, 

respiratory, RERAs, upper airway resistance. In additon, data collected with the MediByte may 
also display pulse rate variability, EKG, bruxism and limb movement event tags. You can select 
up to eight types of events for scoring and the portion of the study to be scored.

The availability of assisted scoring is dependent upon the signals collected. For example, in the 
figure below, limb channels, EKG and Bruxism were not collected so they are unavailable.

1. Select Tools>Assisted Scoring to activate the Assisted Scoring 
screen.

2. Select the type of events you want the program to score.

3. Click Go to start the assisted scoring. A progress bar will appear 
on the screen as the software is calculating the locations of the 
events. When the automated scoring is finished, the progress 
bar will disappear.

4. Review the scored events using the histogram. You may want 
to manually modify the scored events, as discussed on page 6-
28.

We recommend running the assisted scoring for respiratory if you have made changes to 
the desaturation scoring in the data. 

Figure 6.32: Assisted Scoring 
window

Figure 6.33: Histogram showing scored events
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Deleting Scored Events
You can delete all or some of the scored events from a data set using the delete scored events 
function. The software only deletes scored events between the Lights Out and Lights On event 
markers, unless you select Entire Study. If there are no Lights Out and Lights On event markers, 
selecting the Entire Study will automatically delete all event markers from the entire data set.

If you want to remove one or two scored event markers, right click on a marker and select 
Remove This Event.

To delete all of the scoring event markers from the data set:

1. Click Tools>Delete Scored Events to open the Remove Scored 
Events screen.

2. Click on the type of events you want to remove from the data.

3. Click Entire Study if you want all of the events deleted, or 
deselect Entire Study and enter an epoch range.

4. Click Go. A warning window will ask you to verify that you want 
to delete the scored events, click Yes to continue. After the 
program has finished deleting the scored events, the histogram 
will show no scored events of the type you deleted.

Figure 6.34: Remove Scored 
Events window

Figure 6.35: Histogram before deleting UARS events

Figure 6.36: Histogram after deleting UARS events
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Manual Scoring of Events
In the MediByte Software, scoring event markers are colored bars with scoring event 
abbreviations in the top right corners of the display. The table below shows all of the available 
scoring event marker abbreviations, their full names and the channel associated with each 
event. See the glossary for a description of each type of scored event. 

 

Note: You cannot add scoring event markers to epochs scored as 
Wake. If an epoch’s sleep stage is changed from a sleep stage to a 
wake stage, any marked events within the epoch will be hidden.

Table 6-2: Scoring Event Markers

Abbreviation Full name Type Channel

CA Central apnea Assisted or Manual Flow, ThFlow, Sum

OA Obstructive apnea Assisted or Manual Flow, ThFlow, Sum

MA Mixed apnea Assisted or Manual Flow, ThFlow, Sum

HY Hypopnea Assisted or Manual Flow, ThFlow, Sum

CH Central Hypopnea Assisted or Manual Flow, ThFlow, Sum

SuH SubHypopnea Assisted or Manual Chest and Abdomen

RERA Respiratory Related Arousal Assisted or Manual Chest and Abdomen

CS Chenyne-Stokes Manual only Chest and Abdomen

D Desaturation Assisted or Manual SpO2

PRV Pulse Rate Variability Assisted or Manual Pulse

A Arousal Manual only EEG

RA Respiratory Arousal Manual only EEG

SA Snoring Arousal Manual only EEG

DA Desaturation Arousal Manual only EEG

SSD Snoring Sound Assisted or Manual Snore (Audio)
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SNR Snoring Nasal Resistance Assisted or Manual Snore (Flow)

FL Flow limitation Assisted or Manual Snore (Flow)

ASY Asystole Manual only EKG

BRY Bradycardia Manual only EKG

NTY
Narrow Complex 
Tachycardia

Manual only EKG

WTY Wide Complex Tachycardia Manual only EKG

STY Sinus Tachycardia Manual only EKG

VFB Ventricular Fibrillation Manual only EKG

AFB Atrial Fibrillation Manual only EKG

PVC
Premature Ventricular 
Contractions

Manual only EKG

PAC
Premature Atrial 
Contractions

Manual only EKG

LM Limb movement Assisted or Manual Legs (Both)

BRUX Bruxism Assisted or Manual Brux

BAD_SPO2 Bad SpO2 data Assisted or Manual SpO2, Pulse

BAD_ALL Bad data, all channels Manual only All 

Table 6-2: Scoring Event Markers

Abbreviation Full name Type Channel
  6-29
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Scoring Apneas and Hypopneas
Apnea is defined as a cessation of breathing. Hypopnea is defined as breathing that is shallower 
or slower than normal. Hypopnea is distinct from apnea in which there is no breathing.

Score an apnea when the following occurs:

a.  there is a drop in airflow amplitude > 90% of baseline.

b.  the duration is ten seconds or longer

c.  at least 90% of the event duration meets the amplitude reduction criterion.

There are three types of sleep apnea: obstructive, central and mixed.

Obstructive apnea: A breathing disorder 
characterized by brief interruptions of breathing 
during sleep. In obstructive apnea, the muscles 
of the soft palate around the base of the tongue 
and the uvula relax, obstructing the airway. 
Obstructive sleep apnea is characterized by the 
presence of respiratory effort.

Central apnea: A breathing disorder 
characterized by brief interruptions of breathing 
during sleep. Central apnea occurs when the 
brain fails to send the appropriate signals to the 
breathing muscles to initiate respiration; hence, 
central sleep apnea is characterized by a lack of 
respiratory effort. Central sleep apnea is less 
common than obstructive sleep apnea.

Figure 6.37: Obstructive apnea (90-second epoch size)

Figure 6.38: Central apnea (90-second epoch size)
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Mixed apnea: A breathing disorder characterized 
by brief interruptions of breathing during sleep. 
Mixed sleep apnea consists of both central and 
obstructive sleep apnea. 

Score a hypopnea when the following occurs:

a.  airflow amplitude drops by > 30% of baseline

b.  the duration is ten seconds or longer

c.  there is a > 4% desaturation from pre-event 
baseline

d.  at least 90% of the event duration meets the 
amplitude reduction criterion for hypopnea

OR
e.  airflow amplitude drops by > 50% of baseline

f.  the duration is ten seconds or longer

g.  there is a > 3% desaturation from pre-event 
baseline OR the event is associated with an 
arousal

h.  at least 90% of the event duration meets the 
amplitude reduction criterion for hypopnea.

Flow Limitation: A flattening or plateau on the 
inspiratory waveform. This flattening indicates 
increased resistance of airflow through the 
upper airway and is often associated with 
snoring and upper airway resistance syndrome 
(UARS).

Figure 6.39: Mixed apnea (90-second epoch size)

Figure 6.40: Hypopnea - note the accompanying 
desaturation

Figure 6.41: Flow Limitation
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Respiratory Effort Related Arousal (RERA): 
Breaths lasting at least 10 seconds in length 
characterized by increasing respiratory effort or 
flattening of the nasal cannula pressure leading to 
an arousal from sleep when the sequence of 
breaths does not meet the criteria for either an 
apnea or an hypopnea.  A RERA is a milder form of 
sleep disordered breathing than either apnea or 
hypopnea. 

Pulse Rate Variability (PRV): Variation in time 
interval between heartbeats. You can set the rules 
for PRV in the Assisted Scoring Rules screen. The 
default setting for PRV is a minimum change of six 
beats per minute for a minimum duration of one 
second and a maximum duration of 60 seconds. 
The PRV is marked by a black bar above the pulse 
signal.

Figure 6.42: RERA

Figure 6.43: PRV
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Inserting scoring event markers

To insert a scoring event marker:

1. Point to the part of the waveform you want to score.

2. Hold down the left mouse button while moving the mouse over the waveform to the end of 
the area and release the left button — this action is called dragging. The shortcut menu will 
appear when you release the mouse button.

3. From the shortcut menu, click the appropriate scoring event.

4. For subsequent events on the same waveform, point to the part of the waveform you want 
to score and drag the mouse, the software will automatically tag the event with the same 
scoring event marker as the previous event.

Scoring event markers cannot be overlapped.

Figure 6.44:  Shortcut menu
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Deleting scoring event markers
You can delete scoring event markers using delete mode. Toggle delete mode by selecting and 

deselecting the Delete  button on the toolbar.

In delete mode, delete scoring event markers by clicking on them; restore deleted scoring 

markers by clicking the Undo button . The software will stay in delete mode until you 

deselect the Delete button.

To delete a single scoring marker, right-click on the marker and select Remove This Event from 
the shortcut menu; however, you cannot undo deleted event markers when using the right-click 
method.

To delete scoring event markers:

1. Go to the epoch with the scoring event marker to delete. 

2. Click  to turn on delete mode.

3. Click the scoring event marker(s) you want to delete.

4. When you are finished, click  to turn off delete mode.

Restoring deleted scoring event markers
You can only restore deleted scoring event markers if you deleted them using delete mode; you 
cannot restore events that were deleted by right-clicking on the marker and selecting Remove 
This Event from the shortcut menu. 

As soon as you delete a scoring event marker in delete mode, the Undo button becomes 

available. Restore deleted scoring markers by clicking the Undo  button. 

The Undo feature permits the restoring of scoring event markers starting from the last scoring 
event marker deleted up to the time delete mode was activated. When you cannot restore any 
more scoring event markers, the Undo button is unavailable.

To restore deleted scoring event markers:

• Click  as many times as required to restore the events you previously deleted.
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Modifying scoring event markers
With all scoring event markers, change the scoring event at any time by right-clicking on the 
marker and selecting a new scoring event from the shortcut menu.

To modify a scoring event marker:

1. Go to the epoch with the scoring event marker to 
change.

2. Right-click on the scoring event marker, and from the 
shortcut menu, click the appropriate scoring event.

Repositioning scoring event markers
Change the position of any scoring event marker at any 
time by clicking on the marker and dragging it to a new 
location.

To reposition a scoring event marker:

1. Go to the epoch with the scoring event marker you 
want to reposition. 

2. Click the scoring event marker and drag it to the new 
location.

Scoring event markers cannot be overlapped.

Figure 6.45: Modify a scoring event 
marker
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Lengthening or shortening scoring event markers
Change the length of any scoring event marker at any time by positioning the pointer over either 
the left or right border of the scoring event marker and dragging the border. 

To lengthen or shorten a scoring event marker:

1. Go to the epoch with the scoring event marker you 
want to lengthen or shorten.

2. Point to either the right or left border of the scoring 
event marker and you will see a double-headed arrow 
[ ].

3. Drag the border to lengthen or shorten the marker.

Figure 6.46:  Double-headed arrow on 
the event
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Sleep Stage Scoring (MediByte only)
You can manually score sleep stages on the display screen using the keyboard of your computer. 
To score sleep stages, set the screen width to 30 seconds. Press the shortcut key that 
corresponds to the sleep stage you are currently viewing. For example, score the REM stage by 
pressing the 5 key. Pressing the shortcut key for the sleep stage, inserts a watermark 
abbreviation of the sleep stage in the top right corner of the display.

The hypnogram will appear in the histogram as you score the data. 

To insert a sleep stage marker:

1. Set the display screen width to 30s.

2. Click the key corresponding to the sleep stage. The screen will advance to the next epoch so 
you can quickly score the data. 

3. Click the back arrow to view the sleep stage score marker on the top right of the screen.

You can only add sleep stage scores to data that has been collected 
using the Sleep, Sleep + EKG or Sleep + EEG modes. The data will 
display EEG, EOG and EMG.

Table 6-3: Sleep Stage Keys

Sleep Stage Keyboard Displayed

Wakefulness W, A or 0 W

Stage 1 1 N1

Stage 2 2 N2

Stage 3 3 N3

REM 4, 5 or R R

Movement M M
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Manually Mark Arousals (MediByte only)
In data collected using the either of the three sleep modes, you can manually mark arousals on 
the EEG.

To mark an arousal:

1. Click and drag the mouse along the EEG signal to 
mark the arousal. An arousal menu will open.

2. Select the appropriate Arousal Tag by clicking your 
mouse.

To remove an arousal:

1. Right click on an arousal marker to open the Arousal menu.

2. Click on Remove This Event to delete the arousal 
from the data.

Figure 6.47: Arousal menu

Figure 6.48: Removing an arousal
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Mark and Play Audio

You can mark and play audio on the AUDIO channel using the Mark And Play Audio  button. 
This button turns on the audio feature so that you can mark a segment of the AUDIO channel and 
listen to the sounds recorded. This feature is useful for distinguishing snoring from other noises 
that occur during the night. After the segment has finished playing, the yellow marker 
disappears; the data is not permanently marked. Refer to Table 6-4 on page 6-40 for a listing of 
the decibel levels of common sounds.

To mark and play audio:

1. Click  to activate the audio function.

2. Click and drag the mouse along the AUDIO channel to listen to that segment of the data. If 
you click elsewhere on the data, the audio play-back will end.

3. Click  again to turn off the audio function.

Figure 6.49: Using the audio feature
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Table 6-4: Loudness Comparison Chart

Environmental Noise Decibel Level (dB)

Whisper 40-45

Normal conversation 60-70

Telephone dial tone 80

City traffic (inside car) 85

Train whistle at 500’ 90

Subway train at 200’ 95

Level at which sustained exposure may result in hearing loss 90-95

Power mower 107

Power saw 110

Pain begins 125

Pneumatic river at 4’ 125

Jet engine at 100’ 140

Death of hearing tissue 180

Loudest possible sound 194
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Mark and Play Audio with FFT Analysis
When you select the FFT Analysis button, you can mark a segment of the AUDIO channel for 
audio playback and FFT analysis. The software will first playback the segment and then display 
the FFT analysis of the segment in a graph. You can copy the graph to the clipboard for later use 
or print the graph.

To mark and play audio with FFT analysis:

1. Click  to activate the audio and FFT function.

2. Click and drag the mouse along the AUDIO channel to listen to that segment of the data. 
After the audio playback, the Audio-FFT Analysis window opens.

3. To copy the FFT graph to the clipboard, 
click Copy to Clipboard. You can paste 
the image into a document, but if you 
click Copy to Clipboard again, the first 
image will be over-written. You can only 
have one item in the clipboard at a 
time.

4. Click Print to print the Audio FFT graph.

5. Close the Audio-FFT Analysis window.

6. You can continue to highlight segments 
of the AUDIO channel to listen and 
review the FFT analysis graphs as long 
as the FFT button is depressed.

7. Click  again to turn off the audio 
and FFT analysis function.

Figure 6.50: Sample Audio FFT graph pasted directly onto this 
page from the clipboard (sized to 90%)
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Figure 6.51: Audio - FFT Analysis Screen
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Marking Bad Data
The software automatically marks bad data during the initial downloading of the data from the 
MediByte/MediByte Jr SpO2 waveforms of less than 50% will be marked as bad data; pulse rate 

data occurring at the same time will also be marked as bad.

When data is marked as bad, that segment is removed from the statistical calculations by the 
report generator, but this does not affect the recording time statistics.

If your data set does not have automatically marked bad data because it was downloaded with 
an older version of the software, you can run the Assisted Scoring or manually mark the bad 
data. In addition, you can change the bad data markers, as required.

For information about Assisted Scoring, see Starting the Assisted Scoring on page 6-26.

 

Bad data does not affect total recording time.

Figure 6.52: Bad pulse signal marked as bad data
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Manually Marking Bad Data

Manually mark the SpO2/Pulse signals or all of the channels as bad using , the Mark Bad 

Data button. 

To mark bad data:

1. Click  to activate the bad data function.

2. Click and drag the mouse along the signal you want to mark. If 
you are dragging along the SpO2 or Pulse signals, a pop-up will 
show Mark SpO2/Pulse BAD or Mark All Channels BAD. If you 
are dragging on other signals, you will only have the option to 
mark all channels.

3. Select whether you want to mark all the channels as bad or 
only the SpO2/Pulse.

4. Click  to turn off the bad data function.

Lengthening or shortening bad data event markers
Change the length of any bad data event marker at any time by positioning the pointer over 
either the left or right border of the event marker and dragging the border. 

If you mark all channels as bad, you must re-run the assisted scoring 
to ensure that events associated with the bad data are completely 
removed. Deselect bad SpO2/Pulse data in the Assisted Scoring 
Screen before you run the assisted scoring.

Marking all channels as bad will affect total recording time; marking 
SpO2/Pulse as bad will not affect total recording time.

Figure 6.53: Bad data pop-up
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To lengthen or shorten a bad data marker:

1. Go to the epoch(s) with the bad data marker 
you want to lengthen or shorten.

2. Click  to activate the bad data function.

3. Point to either the right or left border of the 
red marker and you will see a double-
headed arrow [ ].

4. Drag the border to lengthen or shorten the 
marker.

Figure 6.54: Changing the bad data marker
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Deleting Bad Data Markers
You can delete all the bad data markers in a data set at once or one by one.

To delete all bad data markers from the data set:

1. Click Tools>Delete Scored Events to open the Remove 
Scored Events screen.

2. Click on Bad SpO2/Pulse Data.

3. Click Entire Study if you want all of the events deleted, or 
deselect Entire Study and enter an epoch range.

4. Click Go. A warning window will ask you to verify that you 
want to delete the scored events, click Yes to continue. After 
the program has finished deleting the scored events, the 
histogram will show no bad data.

To delete one bad data marker:

1. Go to the epoch(s) with the bad data marker you want to 
delete.

2. Click  to activate the bad data function.

3. Right-click on the bad data marker and select Remove This 
Event.

Figure 6.55: Remove All Bad Data 
Markers
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Viewing the Scoring Statistics
Point to a scoring event marker with the mouse cursor to view statistics about the scoring event, 
including:

•   Scoring event label: indicates the abbreviated name for the scoring event.

•   Maximum physical unit: indicates the highest physical unit for the scored event.

•   Minimum physical unit: indicates the lowest physical unit for the scored event.

•   Range between the maximum and minimum physical units: indicates the difference 
between the maximum and minimum physical units.

•   Length of the scoring event: indicates the length in seconds of the scored event.

To view the scoring statistics for a scoring event marker:

• Use the mouse to point to the scoring event marker and the 
scoring statistics will display. 

Figure 6.56: Scoring statistics
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Printing Reports
There are two types of reports you can print: the print screen report and the generated reports. 
The print screen report is simply a picture of the data currently on your computer monitor. The 
generated reports use data from the entire study to create a report.

Studies should be reviewed by a qualified individual. You are required to acknowledge in a 
dialogue box that you have reviewed the study before generating a report. 

To print the current screen:

1. Click  and then select the printer you will use to print the report.

2. Click Print.

Figure 6.57:  Print screen report
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Printing a generated report
After viewing a data file, you can print a full report. Reports are previewed and printed using 
Microsoft Word®. 

To generate a full report:

1. Click . A Select a Report to Create window opens.

2. Highlight the report you want to create and click Create. The available reports are 
dependent upon the type of study recorded. The report types are as follows:

• HST Report (Snoring Report): A one page report that shows the respiratory and snoring 
events and oximetry recorded during the study. The report tabulates respiratory events for 
each body position. 

• SpO2 Report: A one page report showing blood oxygen saturation histograms for each one 
hour segment in the study.

• 2018 HSAT Report: A four page report that shows the sleep summary, sleep stage 
summary, arousal summary, respiratory events by body position and sleep stages, 
oximetry, respiratory events, breath stats and histogram. A sample of this report is at the 
end of this chapter.

• CPAP Report (only available for studies configured for CPAP): This report shows the 
relationship between CPAP pressure and Apnea Hypopnea Index scores and SpO2 nadirs.

3. A question box asks whether you have 
reviewed and verified the results. If you have 
reviewed the results and they are acceptable, 
click Yes. If you have not yet reviewed the 
results, click No and review the results before 
continuing.

4. If this is a new report, it will automatically 
generate. 

Note:  Before generating the full report, click  and enter the 
patient information in the Patient Info window. In addition, 
ensure that you have entered a Lights Out tag at the beginning 
of the data and a Lights On tag at the end of the data.
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5. If you have already made a report for this data, 
an information window will ask whether you 
wish to create a new report or view the existing 
report. If you have made changes to the data 
file, select Create New; otherwise, select View 
Existing. If you select Create New, a window 
will inform you that the system is generating 
the report (as per step 2) which can take a few 
minutes. The report will display on the screen.

6. Since the report is created in Microsoft® Word®, you can make changes to the text of the 
report, if required.

7. Print the report by selecting File>Print in Microsoft® Word®.

Figure 6.58: Confirmation window
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Sample MediByte Report
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Chapter 7: Data Management

In this chapter

This chapter includes: 

• Assigning storage locations

• Moving/archiving study files

• Decompressing zipped files

• Manually moving studies
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Data Management 
The MediByte software controls file names and the directory structure for data management 
purposes. 

All data management occurs within the Studies Data Manager window. You can use the Studies 
Data Manager window to delete study files, move/archive the study files to another folder or 
burn them to a CD/DVD. The software has a data compression feature for zipping the study data 
to save storage space.

Assigning Storage Locations
Before you can move/archive the study files, you need to assign a storage location using the File 
Location Setup window. The software provides four possible storage locations: Studies folder 
(default), two self-assigned folders and CD/DVD.

To assign a storage location

1. Select Tools>File Location Setup to open the 
File Location Setup window.

2. Type the name of the folder in Name.
This name is used only to identify the folder in 
the Studies Data Manager window.

3. Browse to the location of the storage folder 
and select it; or type the name and location of 
the folder you want to create. If the folder 
does not already exist, a pop-up window will 
ask whether you want to create the new folder.

4. If you want the software to compress the study 
file, ensure the checkbox beside Use Zip 
Compression is selected (circled). Once 
compressed, a file cannot be opened; you 
must move it to an uncompressed storage 
location, such as the Studies folder, and the 
software will automatically decompress it. 

5. Click Save.
Figure 7.1: Assigning the storage locations. 
Data compression selected.
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Moving/Archiving Studies Files

1. Select File>Open to open the Studies Data 
Manager window.

2. Click the  button and select the file storage 
location. Here, the file storage location 
selected is Default Studies Folder. If you want 
to burn the data to a disc, select Writable CD/
DVD Drive.

3. Select the studies you want to move/archive. If 
you want to move/archive more than one 
study file at a time, hold the Shift key while 
selecting the files.

4. Click Move/Archive to initiate the move/
archive function.

5. The Move/Archive Files window appears. This 
window shows the files you have chosen to 
move and the location of the storage folder. If 
this is what you want to do, click OK.

6. If you want to change the storage folder 

location, click  and select a new folder 
location. To do this, you must have assigned 
other folder locations in the File Location 
Setup window; see To assign a storage 
location on page 7-2. You can cancel and 
assign more locations, if required.

Figure 7.2: Select the location to move the test files

Figure 7.3: All test files selected using the Shift key

Figure 7.4: Move / Archive Files window showing the 
files to be moved and the destination
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7. If you want the original studies files deleted 
from the source folder, ensure the Delete from 
source when complete checkbox is selected 
(circled in Figure 7.4).

8. Click OK to start the move/archive function.
If you selected the zip compression function, 
the software will compress the data, and then 
copy it to the selected folder.

Decompressing Zipped Files

1. From the Studies Data Manager, click  and 

select the compressed data folder.

2. Click the file(s) you want to decompress and 
click Move/Archive to start the 
decompression.

Figure 7.5: The zipped test files as they appear in the 
Archive folder

Figure 7.6: Selecting a compressed file to move and 
decompress
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3. The Move/Archive Files window appears. This 
window shows the file(s) you have chosen to 
move and the location of the destination 

folder. Click  and select the destination 
folder.

4. If you want the original file(s) deleted from the 
source folder, ensure the Delete from source 
when complete checkbox is selected (circled).

5. Click OK. A copying window will appear, 
showing the progress of the copy. After this 
window, you will see an unzip window, which 
will show the progress of the decompression. 

Manually Moving Studies
Studies are located in the following directory:

C:/Users/Public Documents/Braebon/MediByte/Studies

All files and folders associated with a study are located here. Folders are labeled using the 
following structure:

Last Name First Name Patient ID

For example, Michael Jones who has a patient ID of 123456 will have a study folder named 
Jones Michael 123456.

Within each folder, there may be a number of folders representing more than one study for the 
patient. If you want to manually move a study, you must move the entire folder, otherwise 
information will be lost. We recommend you use the file management tool in the MediByte 
software to move studies.

Figure 7.7: Move / Archive Files window showing the 
file to be moved and the destination folder.
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Chapter 8: Passwords, Displays and Maintenance

In this chapter

This chapter describes how to set the administrator password and user passwords, how to 
change the way the channels are displayed and MediByte maintenance.

This chapter includes: 

• Passwords and Security

• Display Edit

• Cleaning the MediByte

• Maintaining the MediByte and its accessories

• Troubleshooting

• Warranty
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Passwords and Security
The MediByte software uses the initial password MASTER. For security, you can add an 
administrator password and five additional user passwords to the software.

Change Administrator Password

1. Select Tools>Edit Passwords and enter the 
ADMIN Password (MASTER) to open the 
Password Editor screen.

2. Enter a new ADMIN password. The password 
must be 8-10 characters long with one each 
of upper case, lower case, a number and a 
special character.

3. Click OK.

4. Reenter the new ADMIN password.

If you are having difficulty with setting the passwords, please call Technical 
Support at 1.888.462.4841.

Figure 8.1: Create a new ADMIN password



Passwords, Displays and Maintenance
Add Users and Passwords
You can add up to five unique users to the MediByte software. Once the users are set, the 
software will track all user operations with date, time, user name and operation performed in 
the User Operation Log.

1. Select Tools>Edit Passwords and enter the ADMIN Password when prompted. 

2. Enter a new user name and 
password. The password must be at 
least eight characters long with one 
each of upper case, lower case, a 
number and a special character.

3. Click OK.

Only the Administrator can add or edit users and passwords.
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User Operation Log
The User Operation Log is an encrypted text file showing all activity within the software. The 
entries are listed by Date, Time, user and description of the operation. All major operations, such 
as login, analyzing a study, generating a report, and changing passwords are recorded.

Open the User Operation Log

• Click Tools>View Operation Log and enter the ADMIN password when prompted.

The Operation Log opens on the screen.

Only the Administrator can view the unencrypted content in the User Operation 
Log.

Figure 8.2: Enter ADMIN password

Figure 8.3: Sample Operation Log
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Display Edit
The Software Administrator can change and move the waveforms. Before you can change the 
waveforms, you must enable the waveform editing function. 

To enable waveform editing function

1. Select Tools>Enable Display Editing and enter 
the ADMIN password when prompted.

2. Click the checkbox beside Enable Display 
Waveform Edit to enable the waveform editing 
function and click OK.

The waveform editing function is now 
available. You can disable the function by 
selecting Tools>Disable Display Editing.

Only the Administrator can enable the display editing function to change the 
waveforms. Once enabled, any user can modify the display. Be sure to disable the 
editing function to prevent unauthorized editing of waveforms.
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To modify waveforms

1. Double left-click on the waveform label. The screen will change color and a bar will form 
across the waveform.

2. To move the waveform to a new position, click and drag the highlighted bar.

3. To increase the size of the displayed waveform, click and drag the upper and lower edges of 
the display.

Figure 8.4: Click and drag the upper and lower edges of the display (red circle)
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To change the waveform properties

1. Click Edit, located on the far-right of the waveform bar, to open the Display Channel 
Properties window. Here you can change any of the waveform parameters listed.

2. After changing the properties, click OK

3. To clear the current display properties, click New

4. To remove the waveform from the display, click Remove.

Label On-screen name of a waveform.

Signal
Name of the collected signal used as input for the 
waveform.

Position
Percentage location of the midpoint of the waveform 
where 0% is the top of the display and 100% is the 
bottom of the display.

Height
The percentage height the waveform occupies on the 
display.

Upper/
Lower

Upper and lower range of the waveform expressed as 
units.

Invert
Upper and lower values are switched to invert the 
waveform on the display.

Digital
Digital values are placed periodically on the display. 
The display interval is dependent upon the the 
display width. 

HFF
Digital low-pass filter; i.e., the high frequency filter, 
screens out amplitudes above the filter setting.

LFF
Digital hi-pass filter; i.e., the low frequency filter, 
screens out amplitudes below the filter setting.

Notch 60 Hz or 50 Hz band stop filter.

Scale
Permits the proportional adjustment of the upper 
and lower limits of the waveform to improve its 
appearance.

Grid
Places dashed grid lines on the display at the 
specified interval. If the interval is set to zero, only an 
upper and lower grid is drawn on the display.

Figure 8.5: Display Channel Properties 
window
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To Disable Waveform Editing

1. Select Tools>Disable Display Editing and enter 
the ADMIN password when prompted.

2. Click the checkbox beside Enable Display 
Waveform Edit to disable the waveform 
editing function and click OK.

3. Click anywhere on the screen and the 
highlighted edit display bar on the display will 
disappear.

Reset to Default Display
After making changes to the displayed waveforms, you can quickly return to the default display. 
You can only use this feature when the highlighted edit display bar is off.

To reset the display

1. Click Tools>Reset to Default Display and the display will return to the factory default setting. 
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Cleaning the MediByte

The MediByte is a non-sterile device that does not contact the patient. 

Recommended: 

• Disinfection wipes, such as Sono® Wipes1 or Sani-Cloth® Wipes2, which use quaternary 
ammonium (dimethyl ammonium chloride).

• Isopropyl alcohol.

• Damp cloth.

To clean the MediByte:

1. Gently wipe the MediByte with a disinfection wipe, isopropyl alcohol wipe or a damp cloth.

2. Ensure the MediByte is completely dry before using. 

For additional information, refer to the Association for Professionals in Infection Control and 
Epidemiology (APIC) guidelines for selection and use of disinfectants (American Journal of 
Infection Control. Vol. 18, No. 2, April 1990).

To clean the Electrode Box and Communication Cable:

1. Gently wipe the Electrode Box and Communication Cable with a disinfection wipe, isopropyl 
alcohol wipe or a damp cloth.

2. Ensure the Electrode Box and communication cable are completely dry before using.

1. Registered trademark of Sono.
2. Registered trademark of PDI.

Sterilization of the MediByte is NOT required. Do NOT steam autoclave the MediByte 
or damage will occur and void the warranty.

Do NOT immerse the MediByte in any liquids because damage will result. Water 
damage will void the warranty.
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Maintaining the MediByte and Accessories

• The MediByte does not require any maintenance. 

• The MediByte does not require calibration.

The MediByte is only repairable by BRAEBON– trained personnel. The opening of the MediByte 
by unauthorized individuals will void both the safety of the MediByte and the terms and 
conditions of the MediByte warranty.

If your MediByte or any of its accessories are damaged, please contact BRAEBON immediately at 
1.888.462.4841.

Battery Disposal
Please dispose of used batteries responsibly. To locate a battery disposal sight near you, go to 
www.ehso.com.

Unauthorized opening of the MediByte will void both the safety of the MediByte and the 
terms and conditions of the MediByte warranty.

Do NOT use or attempt to service damaged parts. 
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Troubleshooting
If you have difficulty using this product, please verify the following:

If you still experience trouble with the product, contact technical support by telephone at 
1.888.462.4841 or by email at support@braebon.com. Visit our website for solutions to 
Frequently Asked Questions (FAQs): www.braebon.com. 

Problem Solution

No communication 
between the 
computer and the 
MediByte

• Ensure the battery is in the MediByte. 

• Change the battery.

• Check that the MediByte USB cable is plugged into both the MediByte and 
the computer.

• Restart the computer, and after it’s started, plug the USB cable into an 
available USB port and then plug the other end of the cable into the 
MediByte.

• Reinstall the MediByte Software.

Poor signals

• Check that all the sensors and electrodes were connected properly to the 
MediByte and that all sensors were correctly applied to the patient. Since the 
MediByte does not show real-time data collection, you cannot check sensor 
placement while the patient is connected to the unit. You must ensure that 
the patient understands correct placement of sensors before he or she 
leaves your site.

MediByte stops 
collecting data 
prematurely

• The memory is full, retrieve data from the MediByte and then re-program the 
unit. 

• Replace the standard 1/2 AA lithium battery.

Cannot retrieve data 
from MediByte

• Verify the communication between the computer and the MediByte. See “No 
communication between the computer and the MediByte,” above.

MediByte was 
submerged in liquid

• Contact BRAEBON Medical Corporation at 1.888.462.4841 or 
1.888.462.4844. Please have the product model and serial number available 
when you call.
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Warranty
BRAEBON MEDICAL CORPORATION warrants to the first consumer that this MediByte, when shipped in its original 
container, will be free from defective workmanship, performance and materials and agrees that it will, at its option, 
either repair the defect or replace the defective MediByte or part thereof at no charge to the purchaser for parts or labor 
for a time period of one year from the date of purchase. The warranty described herein shall be the sole and exclusive 
warranty granted by BRAEBON MEDICAL CORPORATION and shall be the sole and exclusive remedy available to the 
purchaser. Use of the MediByte constitutes total and complete acceptance of this warranty. Correction of defects, in 
the manner and for the time period described herein, shall constitute complete fulfillment of all liabilities and 
responsibilities of BRAEBON MEDICAL CORPORATION to the purchaser with respect to the MediByte and shall constitute 
full satisfaction of all claims, whether based on contract, negligence, strict liability or otherwise. In no event shall 
BRAEBON MEDICAL CORPORATION be liable, or in any way responsible, for any loss of revenues or damage, direct, 
incidental, or consequential, including property damage, loss of profit, or personal injury resulting from the use or 
misuse of, or the inability to use this product. Nor shall BRAEBON MEDICAL CORPORATION be liable, or in any way 
responsible, for any damages or defects in the MediByte which were caused by abuse, misuse, tampering, neglect, 
incorrect battery type, or repairs or attempted repairs performed by anyone other than an authorized service person. 
This warranty covers the MediByte Model MP-8 and MBJR only. Accessories and consumables have separate 
warranties with different coverage periods.

Warning:  Unauthorized opening of the MediByte will void both the safety of the 
MediByte and the terms and conditions of the MediByte warranty.

Caution:  Failure to use the correct battery type as stated in this User Manual will 
void the warranty. 

Specifications subject to change without notice.



Chapter 9: File Transfer and Remote Scoring

If you are interested in sending or moving files for remote scoring, BRAEBON 
offers a scoring service using Board Certified Sleep Technologists. 

Please contact BRAEBON at 1.888.462.4841 x218 for more details.
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Glossary
A

Abdominal effort port. Located on the 
bottom of the MediByte,® the abdominal effort 
port attaches the abdominal effort belt to the 
recorder.

AHI (Apnea + Hypopnea Index). The total 
number of apnea and hypopneas per hour 
during a test.

Apnea. Cessation of breathing for at least ten 
seconds.

Asystole. An absence of electromechanical 
activity within the heart. 

Atrial Fibrillation. Rapid, uncoordinated firing 
of electrical impulses from multiple sites in 
the upper chambers, which causes ineffective 
contractions.

Auxiliary port. Located on the top of the 
MediByte, the auxiliary port accepts either the 
Snore microphone, or either Electrode Box for 
the EKG or EMG electrodes.

B

Body Mass Index (BMI). A measure of weight 
relative to height. A body mass index over 25 
is considered overweight, over 30 is 
considered obese.

Body position. In the software, five sleep 
positions are identified: left, prone, right, 

supine and standing. The amount of time 
spent sleeping in each position and the 
occurrence of respiratory events in a 
particular position are tabulated.

Bradycardia. A slow heart rate (less than 60 
beats per minute).

Bruxism. Grinding of the teeth during sleep.

C

Central apnea. A breathing disorder 
characterized by brief interruptions of 
breathing during sleep. Central apnea occurs 
when the brain fails to send the appropriate 
signals to the breathing muscles to initiate 
respiration; hence, central sleep apnea is 
characterized by a lack or respiratory effort. 
Central sleep apnea is less common than 
obstructive sleep apnea.

Chest effort port. Located on the bottom of 
the MediByte,® the chest effort port attaches 
the RIP Belt for MediByte to the recorder.

Cheyne-Stokes Breathing. An abnormal 
pattern of breathing characterized by a 
gradual increase in depth and sometimes in 
rate to a maximum depth, followed by a 
decrease resulting in apnea.

Communication port. Located on the bottom 
of the MediByte,® the communication port 
accepts the BRAEBON communication cable. 
Use this port to attach the recorder to the 
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computer to program the recorder and to 
download data from the recorder.

D

Desaturation. Less than normal amount of 
oxygen carried by hemoglobin in the blood. A 
value below 90% is considered abnormal.

E

EKG. Electrocardiogram, a graphical 
recording of the cardiac cycle

Electrodes. Small devices that transmit brain 
waves or other biological electrical signals 
from a patient to a recorder, where the signal 
is amplified and displayed.

EMG. Electromyogram, a graphical record of 
electric currents associated with muscle 
contractions.

Epoch. A standard 30-second page of a sleep 
recording.

EULA. End user licence agreement.

Event button. The event button, located on 
the front of the MediByte,® permits the patient 
to record an event by depressing the button.

F

Flow limitation. A flattening or plateau on 
the inspiratory waveform. This flattening 
indicates increased resistance of airflow 

through the upper airway and is often 
associated with snoring and upper airway 
resistance syndrome (UARS).

H

Histogram. A graphical display of tabulated 
frequencies. In the MediByte software, the 
histogram displays the selected channels and 
scored events in the study.

Hypopnea.  A reduction of >30% amplitude in 
airflow followed by an SpO2 desaturation of 

4% OR  a reduction of >50% amplitude in 
airflow followed by an SpO2 desaturation of 

3%.

M

Mixed apnea. A breathing disorder 
characterized by brief interruptions of 
breathing during sleep. Mixed sleep apnea 
consists of both central and obstructive sleep 
apnea.

O

Obstructive apnea. A breathing disorder 
characterized by brief interruptions of 
breathing during sleep. In obstructive apnea, 
the muscles of the soft palate around the base 
of the tongue and the uvula relax, obstructing 
the airway. Obstructive sleep apnea is 
characterized by the presence of respiratory 
effort.
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Obstructive hypopnea. An episode of 
diminished breathing during sleep, caused by 
a partial airway obstruction, usually 
accompanied by oxygen desaturation.

Oximeter. A medical device used to provide 
estimates of arterial oxygen saturation by 
using selected wavelengths of light to 
determine the saturation of oxyhemoglobin 
(SpO2).

Oxygen saturation. A measure of oxygen 
carried by hemoglobin in the blood. Normal 
values range from 90% to 100%. An important 
indicator of sleep disordered breathing that is 
directly affected by the degree of throat 
closure and its duration.

P

PLM. Periodic Limb Movement Disorder. 
Characterized by periodic episodes of 
repetitive limb movements during sleep. The 
movements are often associated with a partial 
arousal or awakening; however, the patient is 
usually unaware of the limb movements or 
frequent sleep disruption.

Pressure port. Located on the top of the 
MediByte,® the pressure port accepts the oral/
nasal cannula.

Premature arterial contractions. Extra 
heartbeats originating from the atrial 
chambers. 

Premature ventricular contractions. Extra 
heartbeats originating from the ventricles. 
PVCs interrupt the normal heart rhythm and 

cause an irregular beat. This is often felt as a 
missed beat or a flip-flop in the chest.

R

RDI (Respiratory Disturbance Index. An 
index used to assess the severity of sleep 
apnea based on the total number of complete 
cessations (apnea) and partial obstructions 
(hypopnea) of breathing occurring per hour of 
sleep. These pauses in breathing must last for 
ten seconds and are associated with a 
decrease in oxygen saturation of the blood.

RERA (Respiratory Effort Related 
Arousal). Breaths lasting at least 10 seconds 
in length characterized by increasing 
respiratory effort or flattening of the nasal 
cannula pressure leading to an arousal from 
sleep when the sequence of breaths does not 
meet the criteria for either an apnea or an 
hypopnea.  A RERA is a milder form of sleep 
disordered breathing than either apnea or 
hypopnea. 

S

Scale. Scaling the display improves the 
appearance of the waveforms, but does not 
change the data. Scaling takes the maximum 
and minimum values of the waveforms and 
adjusts the upper and lower limits of the 
waveforms proportionally.

Scoring tags. In the MediByte software, 
respiratory, PLM and snoring events markers 
are colored bars with scoring event 
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abbreviations in the top right corners of the 
display.

Sinus tachycardia. A fast rhythm (more than 
100 beats per minute) originating at the sinus 
node.

Snoring. Sounds made during sleep caused by 
breathing vibrations in the pharynx. In the 
diagnosis of obstructive sleep apnea, snoring 
volume and frequency of occurrence often 
correlate with the severity of the condition.

SpO2 port. Located on the top of the 
MediByte,® the SpO2 port attaches the SpO2 
sensor to the recorder.

U

User event. A note placed in the data to mark 
a significant event, such as lights on, lights off, 
bathroom break.

V

Ventricular Fibrillation. Uncoordinated 
contraction of the cardiac muscle of the 
ventricles in the heart, making them quiver 
rather than contract properly. Ventricular 
fibrillation is the most commonly identified 
arrhythmia in cardiac arrest patients

W

Waist-to-hip ratio (WHR). A calculation 
comparing waist circumference to hip 
circumference; a simple measure of where fat 

is stored in your body. Most people store their 
body fat in two places: around their waist and 
around their hips. Storing extra weight around 
your waist (apple shaped) puts a person at a 
higher health risk than someone carrying 
extra weight around their hips and thighs 
(pear shaped). According to a study published 
in The Lancet, WHR is a better predictor of 
heart attack risk than BMI.*

*Lancet, 2005 November; 366 (9497) 1640-9
Obesity and the risk of myocardial infarction 

on 27,000 participants from 52 countries: a 
case-control study. Yusuf, Hawken et al.

Table 1-1: Waist to Hip Ratio (WHR) Chart

Male Female
Health Risk 
Based Solely 
on WHR

  Low risk

0.96 - 1.0 0.81 - 0.85 Moderate Risk

1.0  High Risk
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Password 6-4
Patient ID 4-4

Patient Info screen 6-14
Patient Information 4-4
Patient Information window 4-4
Physiological signals 1-15
Playing audio 6-39
PLM 5-19, 6-28
PLM scoring event markers

deleting, 6-34
inserting, 6-33
modifying, 6-35

Power 2-3
Premature Atrial Contractions 6-29
Premature Ventricular Contractions 6-29
PRESSURE 5-4, 5-7, 5-12, 5-13
Pressure port 1-15, 1-16, 1-19
Print 6-48
Print current screen 6-48
PRV 6-28
Pulse 6-29
Pulse Rate Variability 6-24, 6-28
Pulse Rate Variability (PRV) 6-32
Pursuit Sleep 1-20, 4-1, 4-2

using 4-1, 4-2, 6-5
PVC 6-29

R

Range 6-47
RDI 1-3
Rechargeable battery 1-21
Red light 2-5
Remove This Event 6-27, 6-34
Report

AHI 6-52
Pulse ranges 6-52
RDI 6-52
Study parameters 6-52

Reports 6-49
RERA 6-28, 6-32, 1-3
Respiratory Disturbance Index 1-3
Respiratory Effort Related Arousal 6-32
Respiratory events setting 6-24
Respiratory Related Arousal 6-28
Respiratory scoring event markers

deleting, 6-34
inserting, 6-33
modifying, 6-35
  i-3



i-4  

Index
Review existing data file 4-4
Reviewing data 6-7
Reviewing screens

from the histogram, 6-10
from the Jump to Event Marker list, 6-19

S

Scale a channel 6-17
Scaling 6-16
Scoring apneas 6-30
Scoring event label 6-47
Scoring event markers

deleting, 6-34
inserting, 6-33
lengthening, 6-36
modifying 6-35
modifying, 6-35
repositioning 6-35
restoring 6-34
shortening 6-36, 6-44
shortening, 6-36

Scoring event statistics 6-47
Scoring hypopneas 6-31
Screen 6-5
Screens

reviewing from the histogram, 6-10
Search the data by scored event 6-11
Search the data by signal 6-10
Search the data by time 6-10
Sensitivity 6-18
Sensor placement

snore study 5-2
Shortening scoring event markers 6-36, 6-45, 6-46
Shortening scoring event markers, 6-36
Signals recorded 1-15
Sinus Tachycardia 6-29
Snore (Audio) 6-28
Snore (Flow) 6-29
Snore microphone 4-5
Snoring 6-28
Snoring Nasal Resistance 6-29
Snoring scoring event markers

deleting, 6-34
modifying, 6-35

Snoring Sound 6-28
SNR 6-29

Software 1-20, 4-1, 4-2, 6-5, 6-7
Software installation 3-1
SpO2 6-28
SpO2 port 1-15, 1-16, 1-19
SSD 6-28
Start collecting

automatic 4-6
manual 4-6

Start Time 4-6
Starting the study 5-23
Status LED 1-15, 1-19
Studies Data Manager window 7-2
Study 4-1, 4-2
STY 6-29
Sum 6-28
Summary 4-7
Switch 2-5

T

ThFlow 6-28
Troubleshooting

can’t retrieve data, 8-11
no data communication, 8-11
poor signals, 8-11
premature stop to data collection, 8-11
water damage, 8-11

U

UARS 6-31
UARS setting 6-24
Undo button 6-34
User event markers 6-19

deleting 6-20
inserting 6-19

User events
deleting, 6-20
jumping to, 6-19

V

Ventricular Fibrillation 6-29
VFB 6-29
Viewing

scoring event marker statistics, 6-47



Index
W

Waist-to-hip ratio 1-4
Warnings 1-7
Waveforms, flat 6-16
Weight 2-3
What do you want to do today? 4-4, 6-2
WHR 1-4
Wide Complex Tachycardia 6-29
WTY 6-29

Z

Zip compression 7-2
  i-5







                                                                                                D.MB.40600.3Date of Issue: August 28, 2023 Version 3

Customer Sales, Technical Support: 1-888-462-4841 (9 am - 5 pm ET) 

• E–mail:support@braebon.com

www.braebon.com 

EU Notice: Any serious incident that has occurred in relation to this device should be reported to 
the manufacturer and the competent authority of the Member State in which the user and/or patient 
is established.

CEpartner4U BV
Esdoornlaan 13
3951 DB Mearn
The Netherlands
www.cepartner4u.eu

0413

BRAEBON Medical
1-100 Schneider Road
Kanata, Ontario, 
Canada, K2K 1Y2


	Chapter 1: Introduction
	What’s New in MediByte Software 9.0
	Intended Use
	Indications
	Contraindications
	Symbols Used On the Device and Guides
	Symbols for the MediByte and MediByte Jr
	Warnings and Cautions
	Battery Warning Saft LS14250:
	Battery Warning BRAEBON Rechargeable:



	Contents of the MediByte Kit
	Contents of the MediByte Lite Kit
	Contents of the MediByte Jr Kit
	Battery Charger Kit (Models 0444-N.A., 0445-E.U.)
	Overview of the MediByte and MediByte Jr
	Description of the MediByte and MediByte Jr
	The MediByte Recorder
	The MediByte Jr Recorder
	BRAEBON Batteries
	Chapter 2: Specifications
	System Requirements
	MediByte and MediByte Jr Classification and Specifications
	Displays and Indicators
	Manufacturer’s Declaration
	Chapter 3: Installing the Software
	Installing the MediByte Software
	Connecting the MediByte to the Computer
	Activating the MediByte Software
	Chapter 4: Preparing the MediByte
	Preparing the MediByte for a Study
	Chapter 5: Preparing the Patient
	MediByte Jr Study
	CPAP Pressure Study (MediByte Jr)
	Snore Study (MediByte)
	Starting the Study
	Ending the Study
	Chapter 6: Reviewing Data
	Downloading Data from the MediByte/MediByte Jr
	Open a New Data File
	Open a Study without the MediByte
	Data Display Screen
	Changing the Language Used in the Software
	Reviewing the Data
	Reviewing Data with the Histogram
	Using the Study Navigator
	Study Status Bar
	Lights Out/Lights On Tags
	Patient Information
	Scaling the Display
	Changing the Appearance of a Signal
	Jumping to Event Markers
	Inserting User Event Markers
	Deleting Event Markers
	Enter Observations
	View the Photoplethysmograph Signal
	Assisted Scoring of Events
	Changing the Assisted Scoring Rules
	Starting the Assisted Scoring
	Deleting Scored Events
	Manual Scoring of Events
	Scoring Apneas and Hypopneas
	Inserting scoring event markers
	Deleting scoring event markers
	Restoring deleted scoring event markers
	Modifying scoring event markers
	Repositioning scoring event markers
	Lengthening or shortening scoring event markers
	Sleep Stage Scoring (MediByte only)
	Manually Mark Arousals (MediByte only)
	Mark and Play Audio
	Mark and Play Audio with FFT Analysis
	Marking Bad Data
	Manually Marking Bad Data
	Lengthening or shortening bad data event markers
	Deleting Bad Data Markers
	Viewing the Scoring Statistics
	Printing Reports
	Sample MediByte Report
	Chapter 7: Data Management
	Data Management
	Assigning Storage Locations
	Moving/Archiving Studies Files
	Decompressing Zipped Files
	Manually Moving Studies
	Chapter 8: Passwords, Displays and Maintenance
	Passwords and Security
	User Operation Log
	Display Edit
	Reset to Default Display
	Cleaning the MediByte
	Maintaining the MediByte and Accessories
	Battery Disposal
	Troubleshooting
	Warranty
	Chapter 9: File Transfer and Remote Scoring
	Glossary
	Index



